CHAPTER 1

Introduction to
Computer Graphics and 3D

T h@S bOOk ?/S intended to introduce you to the workings of 3D animation
(called computer graphics, or CG) with one of the most popular programs on the mar-
ket, Autodesk Maya. It will introduce you to many of Maya’s features and capabilities
with the intent of energizing you to further study.

Having said that, let’s face a basic fact: The best way to succeed at almost anything
is to practice. Prepare to go through the exercises in this book, but also try to think of
exercises and projects that can take you further in your learning process. A book, class,
or video can take you only so far; the rest is up to you. Imagination and exploration will
serve you well.

This is not to say you can’t be a casual visitor to working in CG—far from it. Playing
around and seeing what you can create in this medium is just flat-out fun. Don’t lose
sight of that. If you feel the enjoyment slipping away, step away from the screen for a
while. Understanding your own learning pace is important.

Throughout this book, you’ll learn how to work with Maya tools and techniques at a
pace you set for yourself. This chapter will prepare you for the hands-on study that fol-
lows by introducing the most important CG concepts and the roles they will play in your
Maya work. When you’re learning how to work with Maya, the most important concept
is discovering how you work as an artist. If you have a basic understanding of the meth-
odology and terms of computer art and CG, you can skim or even skip this chapter and
jump right into working with Maya.

Topics in this chapter include:

Art?

Computer graphics

The stages of production
The CG production workflow
Core concepts

Basic film concepts
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Art?

Art, in many instances, requires transcendence of its medium; it speaks of its own
accord. Art goes beyond the mechanics of how you create it (whether by brush or mouse)
and takes on its own life. Learning to look beyond what youre working with and seeing
what you’re working for is the key to creating art with CG. Try not to view this experience
as learning a software package, but as learning a way of working to an end. As you begin
learning 3D with Maya, you acquire a new language—a new form of communication.
Keep in mind that the techniques you acquire are only a means to the end.

Relax and enjoy yourself.

It’s hard to relax when you’re trying to cram so much information into your brain.
But keep in mind that you should try not to make this experience about how a software
program works; instead, make it about how you work with the software. Maya is only
your tool.

When hiring professional 3D artists, CG studios keenly look for a strong artistic sense,
whether in a traditional portfolio or a CG reel. Therefore, it’s paramount to fortify the
artist within yourself and practice traditional art such as life drawing, photography, paint-
ing, or sculpture as you learn CG, beginning with the core principles introduced in this
first chapter. Keep in mind that the computer you’ll be using for 3D work is nothing more
than a tool. You run it; it doesn’t run you.

3D is a part of the daily visual lexicon. With the availability of inexpensive and fast
computers, everyone can create their own CG projects. Artists everywhere are adding
the language of CG to their skill set. So before you start learning a particular CG tool—
Maya, in this case—make sure you have a grasp of the fundamental issues underlying
CG. It’s important.

Computer Graphics

CG and CGI are the abbreviations for computer graphics and computer graphics imagery,
respectively, and are often used interchangeably. CG literally refers to any picture or
series of pictures that is generated by an artist on a computer. However, the industry con-
vention is to use the terms CG and CGI to refer to 3D graphics and not to images created
using 2D image or paint programs such as Photoshop.

Most 2D graphics software is bitmap based, whereas all 3D software is vector based.
Bitmap-based software creates an image as a mosaic of pixels, filled in one at a time. Vector-
based software creates an image as a series of mathematical instructions from one calcu-
lated, or graphed, point to another. This much more powerful method for creating graphics
is behind all the impressive CG images you’ve seen in movies, videogames, and so on. It’s
also the method for the images you’ll soon create with Maya. You’ll learn more about vec-
tors and bitmaps in the section “Computer Graphics Concepts” later in this chapter.
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If you’re familiar with 2D graphics software, such as Adobe Illustrator or Adobe Flash,
you already know something about vectors. Maya and other 3D graphics tools add the
calculation of depth. Instead of drawing objects on a flat plane, they’re defined in three-
dimensional space. This makes the artist’s job fairly cerebral and very different than it
is for 2D art; in 3D art, there is more of a dialogue between the left and right sides of the
brain. When working with 3D graphics tools, you get a better sense of manipulating and
working with objects, as opposed to dealing with the lines, shapes, and colors used to cre-
ate 2D images.

A Preview of the 3D Process

The process of creating in 3D requires that you either model or arrange prebuilt objects
in a scene, give them color and light, and render them through a virtual camera to make
an image. In essence, you create a scene that tells the computer what objects are in the
scene, where the objects are located, what the colors and textures of the objects are, what
lighting is available, and which camera to use in the scene. It’s a lot like directing a live-
action production, but without any actor tantrums.

A large community on the Web provides free and for-pay models that you can use in your
scenes. Sites such as www. turbosquid.comand www.archive3d.net can cut out a lot of the
time you might spend creating all the models for a CG scene. This gives you the chance to

skip at least some of the modeling process, if that isn't your thing.

With CG, you work in 3D space—an open area in which you define your objects,
set their colors and textures, and position lights as if you were setting up for a live
photo shoot. CG is remarkably analogous to the art and practice of photography and
filmmaking.

Photographers lay out a scene by placing the subjects into the frame of the photo. They
light the area for a specific mood, account for the film qualities in use, adjust the lens
aperture, and fine-tune for the colors of the scene. They choose the camera, film, and lens
based on their desired result. Then, they snap the pictures and digitally transfer them or
develop them to paper. Through this process, a photo is born.

After you build your scene in 3D using models, lights, and a camera, the computer
renders the scene, converting it to a 2D image. Through setup and rendering, CGI is
born—and, with a little luck, a CG artist is also born.

Rendering is the process of calculating lights and shadows, the placement of textures and
colors on models, the movement of animated objects, and so on to produce a sequence
of 2D pictures that effectively “shoot” your virtual scene. Instead of an envelope of 4 x 6
glossy prints, you get a sequence of 2D computer images (or a QuickTime or AVI [Audio
Video Interleave] movie file) that sit on your hard drive waiting to be seen, and invariably
commented on, by your know-it-all friends.
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In a nutshell, that is the CG process. You’ll need to practice planning and patience,
because CG follows conventions that are different from those for painting programs and
image editors. The CG workflow is based on building, arrangements, and relationships.
But it’s an easy workflow to pick up and master in time. It can be learned by anyone with
the desire and the patience to give it a try.

Animation

Animation is change over time. In other words, animation is the simulation of an object
changing over a period of time, whether it’s that object’s position or size, or even color
or shape. In addition to working in the three dimensions of space, Maya animators work
with a fourth dimension: time.

All animation, from paper flipbooks to film to Maya, is based on the principle that
when we see a series of rapidly changing images, we perceive the changing of the image
to be in continuous motion. If you have a chance to pause and step through an animated
film, frame by frame, on your DVD player or DVR, you’ll see how animation comes
together, literally step by step.

To create CG animation yourself, you have to create scene files with objects that
exhibit some sort of change, whether through movement, color shift, growth, or other
behavior. But just as with flipbooks and film animation, the change you’re animating
occurs between static images, called frames, a term carried over from film. You define
the object’s animation using a timeline measured in these single frames.

You’ll learn more in the section “Basic Animation Concepts” later in this chapter. For
now, let’s move on to the stages of CG production.

The Stages of Production

The CG animation industry inherited a workflow from the film industry that consists of
three broad stages: preproduction, production, and post production. In film, preproduc-
tion is the process in which the script and storyboards are written, costumes and sets are
designed and built, actors are cast and rehearsed, the crew is hired, and the equipment is
rented and set up. In the production phase, scenes are taped or filmed in the most efficient
order. Post production (often simply called post) describes everything that happens after-
ward: The scenes are edited into a story; a musical score, sound effects, and additional dia-
logue are added; and visual effects may also be added. (In a film that has special effects or
animation, the actual CG creation is usually completed in post production. However, it
may start in the preproduction phases of the film or project.)

Although the work performed at each stage is radically different, this is a useful
framework for understanding the process of creating CG as well.
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Preproduction

Preproduction for a CG animation means gathering reference materials, motion tests,
layout drawings, model sketches, and such together to make the actual CG production as
straightforward as possible.

Because CG artists are responsible for defining their 3D scenes from the ground up,
it’s essential to have a succinct plan of attack for a well-organized production. The more
time spent planning and organizing for CG, the better. Whether you’re working on a
small job or a complex film, entering into production without a good plan of attack will
not only cause trouble, but also stunt the growth of your project.

In the real world, preproduction is part of every CG animation project. For the tutorial
projects in this book, the sketches and other files supplied on the accompanying CD are
your preproduction. Even for these tutorials, however, you should try to gather as much
information as you can about the objects you’ll create, going beyond what is presented.
Having different perspectives on a subject is the key to understanding it. Disappointing
movies often are the product of terribly flawed preproduction stages; likewise, a poorly
thought-out CG production will invariably end in headaches and wasted time.

The Script

To tell a story, CG or not, you should put it in words. A story doesn’t need to contain
dialogue for it to benefit from a script. Even abstract animations benefit from a detailed
explanation of timings and colors laid out in a treatment (because there is likely no dia-
logue). The script or treatment serves as the initial blueprint for the animation, a place
where you lay out the all-important intent.

The Storyboard

A storyboard is a further definition of the script. Even a rudimentary storyboard with
stick figures on notebook paper is useful to a production. You break the script into
scenes, and then you break those scenes into shots. Next, you sketch out each shot in a
panel of a storyboard. The panels are laid out in order according to the script to give a
visual and linear explanation of the story. Storyboards are useful for planning camera
angles (framing a shot), position of characters, lighting, mood, and so on.

The Conceptual Art

Conceptuals are the design elements that you may need for the CG production. Typically,
characters are drawn into character sheets in three different neutral poses: from the
front, from the side, and from an angle called a 3/4 view. You can also create color art for
the various sets, props, and characters to better visualize the colors, textures, and light-
ing that will be needed. Props and sets are identified from the script and boards and then
sketched out into model sheets. The better you visualize the conceptual art, the easier it
will be to model, texture, and light everything in CG.
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Production

Production begins when you start creating models from the boards, model sheets, and
concept art. You model the characters, sets, and props, and then you assign textures (col-
ors, patterns). The animators take the models and animate everything according to the
boards and script. The sequences are rendered in low quality for dailies and checked for
accuracy and content.

The CG production phase can involve a variety of steps. The specific steps are defined
by the needs of the production. Most of the CG techniques you’ll learn in this book are
part of the production phase. To make a long story short, 3D scenes are created, lit, and
animated in the production phase.

Post Production

After all the scenes have been set up with props and characters and everything is ani-
mated, post production can begin. Post production for a CG project is similar to post
production for a film. This is where all of a CG film’s elements are brought together and
assembled into final form.

Rendering

Rendering is the process by which the computer calculates how everything in the scene
should look and then displays it. As you’ll learn throughout this book, the decisions you
make in creating the objects in a scene can make a big difference in how the rest of the
process goes.

Rendering makes significant processing demands on your computer, usually requiring
the full attention of your PC. This can take a considerable amount of time. You can ren-
der one scene while another scene is in production, but asking a computer that is render-
ing to multitask isn’t advisable unless youre using a dual-processor machine with plenty
of memory.

When everything is rendered properly, the final images are sorted, and the assembly
of the CG project begins. Rendering is discussed more fully in Chapter 11, “Maya
Rendering.”

We’ll take a quick look at three more post-production activities: compositing, editing,
and adding sound. These are advanced topics, and complete coverage is beyond the scope
of Introducing Maya 2011. However, a multitude of books are available on these topics for
further study.

Compositing

Quite often, CG is rendered in different layers and segments, which need to be put back
together. In a particular scene, for example, multiple characters interact. Each charac-
ter is rendered separately from the others and from the backgrounds. They’re then put
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together in compositing, or the process of bringing together scene elements that were
created separately to form the final scene. Maya makes this process easier with Render
Layers, which you’ll experience in Chapter 11.

Compositing programs such as Maya Composite, Nuke, Digital Fusion, and After
Effects allow you to compose CG elements together and give you some additional con-
trol over color, timing, and a host of other additions and alterations you can make to the
images. Compositing can greatly affect the look of a CG project and can be an integral
part of CG creation.

Many new animators try to generate their final images in a single rendering of their scene,
but you don’t need to do that. Realizing the component nature of CG is important; you can
use components to your advantage by rendering items separately and compositing them
together in the finishing stage. This gives you a lot of control in finishing the images to your

satisfaction without always having to go back, change the scene, and re-render it.

Editing

The rendered and composited CG footage is collected and edited together to conform
to the script and boards. Some scenes are cut or are moved around to heighten the story.
This is essentially the same process as film editing, with one big difference: the amount
of footage used.

To make sure they have adequate coverage for all their scenes and to leave extra
room for creativity in editing, live-action filmmakers shoot quite a bit more footage
than is needed for a film. The editor and the director sift through all the scenes and
arrange them to assemble the film in a way that works best with what they have shot
and with the performances they prefer. A typical film uses a fraction of all the film or
video that is shot.

Because creating CG is typically more time-consuming and expensive than shoot-
ing live action, scenes and shots are often tightly arranged in preproduction boards so
not much effort is wasted. The entire production is edited with great care beforehand,
and the scenes are built and animated to match the story, almost down to the frame.
Consequently, the physical editing process consists mostly of assembling the scenes into
the sequence of the story. This is also why a good preproduction process is important.
When you plan out what you want to get, youre much more likely to get it.

Sound

Sound design is critical to CG because viewers associate visuals with audio. A basic sound-
track can give a significant punch to a simple animation by helping to provide realism,
mood, narrative, and so on, adding a greater impact to the CG.

7
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Sound effects, such as footsteps, are inserted to match the action on the screen. This
type of sound is also known in film as Foley sound. Music is scored and added to match
the film. Quite often, the dialogue or musical score inspires a character’s actions or body
language. Again, this is much the same procedure as in film, with one exception. In the
event that a CG project requires dialogue, the dialogue must be recorded and edited
before CG production can begin. Dialogue is a part of the preproduction phase as well
as a component of post production. This is because animators need to hear the dialogue
being spoken so they can coordinate the lip movements of the characters speaking, a pro-
cess known as lip-synch.

How It All Works Together

The process behind making a South Park episode is a perfect workflow example. Although
the show appears to be animated using paper cutouts, as was the original Christmas short,
the actual production work is now done using Maya. In preproduction on a typical epi-
sode, the writers hammer out the script, and the voice talent records all the voices before
the art department creates the visuals for the show. The script is storyboarded, and copies
are distributed to all the animators and layout artists.

At the beginning of the production phase, each scene is set up with the proper back-
grounds and characters in Maya and then handed off for lip-synch, which is the first step
in the animation of the scene. The voices are digitized into computer files for lip-synch
animators who animate the mouths of the characters. The lip-synched animation is then
passed to character animators who use the storyboards and the soundtrack to animate
the characters in the Maya scene.

The animation is then rendered to start the post, edited together following the boards,
and then sent back to the sound department for any sound effects needed to round out
the scene. The episode is assembled and then sent off on tape for broadcast.

The CG Production Workflow

Because of the nature of CG and how scenes must be built, a specific workflow works best.
Modeling almost always begins the process, which then can lead into texturing, and then
to animation (or animation and then texturing). Lighting should follow, with render-
ing pulling up the rear as it must. (Of course, the process isn’t completely linear; you’ll
often go back and forth adjusting models, lights, and textures throughout the process.)
Chapters 4 through 11 follow this overall sequence, presenting the major Maya opera-
tions in the same order you’ll use in real-world CG projects.

Modeling

Modeling, the topic of Chapters 4 through 6, is usually the first step in creating CG. It’s
the topic that garners a lot of coverage in publications and captures the interest of most
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budding CG artists. You most often start a CG scene by creating the objects you need to
occupy your space. It can end up taking the majority of the time in your process. This

is why downloading or purchasing models from the Internet can often cut down the
amount of time you spend on your project. This, of course, assumes you're not a fan of
modeling and prefer to spend your time animating or working on texturing and lighting.

There are many modeling techniques, and each could be the subject of its own series of
books. The choice of which technique to use usually depends on the modeler’s taste and
preferred workflow. The choices are among polygonal modeling (Chapter 4, “Beginning
Polygonal Modeling”), NURBS modeling, and subdivision surface (SubD) modeling
(Chapter 5, “Modeling with NURBS, Subdivisions, and Deformers”). Knowing how an
object is used in a scene gives you its criteria for modeling. You never want to spend more
time on a model than is needed. Creating a highly detailed model for a faraway shot will
waste your time and expand rendering times needlessly. If you need to see a park bench
in a wide shot from far away, the model doesn’t need abundant detail or complicated sur-
facing. You can usually create any required details for it by just adding textures. However,
if that park bench is featured prominently in a close-up, it needs as much detail as pos-
sible because viewers will see more of the bench. You’ll learn more about this aspect of
modeling in Chapter 4.

The more you use models in scenes, the better you’ll develop your eye for exactly how
much detail to provide. When you're starting out, however, it’s a good idea to lavish as
much attention on detail as you can; this can teach you perhaps 70 percent of what you
can learn about modeling, which in turn will benefit your overall speed and technique.
As you gain more experience, you'll be able to discern exactly how much detail to add to
a scene and not go overboard.

Character Modeling

Character modeling usually involves organic forms, such as animals, humans, aliens,
and such. Practically anything that is animated and portrays a character in a scene can
be referred to as a character model. You need to create these with animation techniques in
mind, as well as accuracy of form.

Some organic characters (for example, critters and people, as opposed to robots with
mechanical parts and hard edges) are built with patches of surfaces stitched together or
as single objects that are stretched and pulled into shape. Character models need to look
seamless because most character animation requires the model to deform in some way—
to bend and warp at certain areas such as the joints.

A character modeler needs to keep the future of the character in mind to allow for
particular character animation methods that will be used. Quite frequently, you’ll create
several models for a character to account for different uses of that character and to keep
the scene efficient and workable. You may create one character with fine facial detail for
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close-up speaking scenes and another with hardly any details for walk cycles in distant
shots. Listen to your mother: don’t get in over your head; do as much as you know you
can finish properly.

Architectural and Environment Modeling

Architectural and environmental modeling includes architectural previsualization for the
design of buildings as well as the generation of backgrounds for sets and environments.
Typically, it involves modeling buildings or interiors as well as mountains or anything
that is required for the scenery, such as benches, chairs, lampposts, and so on.

You shouldn’t create incredibly detailed environments, especially ones that use a lot of
geometry (that is, the objects in your scene), if they aren’t closely featured in a shot. The
greater the amount of geometry, the slower your computer will run and the longer ren-
dering will take. If you reach a critical mass of too much geometry in your scene, it may
not even render. You can create much of an environment by using clever textures and
matte paintings on simple geometry. Matte paintings, which are detailed maps on bare
surfaces, are used frequently for game environments. The rule of thumb for all kinds of
CG is “use whatever works.”

Because your computer stores everything in the scene as vector math, the term geometry

refers to all the surfaces and models in a scene.

Props Modeling

Props modeling covers almost everything else needed in the scene. In theater and film
terms, a prop is an object used by a character in the action; anything relegated to the
scenery or background is a scenic. For example, a prop can be a purse a character is car-
rying, a leash on an animated dog, or a car a character is driving. If the car or purse were
just sitting in the background, it would be considered a scenic.

Texturing

When the models are complete, it’s a good idea to begin texturing and shading, the pro-
cess of applying colors and textures to an object to make it renderable. When you create
an object in Maya, for example, a simple gray default shader is automatically assigned to
it that will let you see the object when you light and render the scene.

Because the textures may look different after animating and lighting the scene, it’s
wise to leave the final adjustments for later. Just as a painter will pencil in a sketch before
adding details, you don’t need to make all the shading adjustments right away; you can
return to any part of your scene in Maya and adjust it to fine-tune the picture.

You’ll learn more about texturing and shading in Chapter 7, “Maya Shading and
Texturing.”
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Animation

You can make or break your scene with animation. We all have an innate sense of how
things are supposed to move on a visceral level, if not an academic one. We understand
how physics applies to objects and how people and animals move around. Because of this,
viewers tend to be critical of CG’s motion if it’s not lifelike. Put bluntly, you know when
something doesn’t look right, and so will the people watching your animation.

To animate something properly, you may need to do quite a lot of setup beyond just
modeling. Depending on the kind of animating you’ll be doing, you may need to set up
the models for however you've decided to animate them. For example, for character ani-
mation, you'll need to create and attach an armature, or skeleton, to manipulate the char-
acter and to make it move like a puppet in order to do your bidding.

Taking the models you’ve spent hours detailing and reworking and giving them life is
thrilling and can make any detailed modeling and setup routine well worth the effort.

Chapter 8, “Introduction to Animation,” and Chapter 9, “More Animation!” cover
animation techniques in Maya.

Lighting

CG is fundamentally all about light. Manipulating how light is created and reflected is
what you're doing with CG. Without light, we wouldn’t see anything, so it makes sense
that simulating light is the most influential step in CG. Lighting can drastically alter the
look of your scene; it greatly affects the believability of your models and textures and cre-
ates and heightens mood.

During the lighting step, you set up virtual lights in your scene to illuminate your
objects and action. Although you can set up some initial lights during the texturing of
the scene, the serious lighting should be the last thing you do, aside from changes and
tweaks.

The type and number of lights you use in a scene greatly affect not just the look of
your scene, but also the amount of time the scene takes to render. Lighting becomes a
careful dance between pragmatics and results. It’s perhaps the subtlest part of CG to
master.

When you gain more experience with lighting, you’ll notice that it affects every part
of your CG creation. Before long, you'll start modeling differently—that is, modeling
with the final lighting of the scene in mind. Texturing will change when you keep light-
ing techniques in mind. Even your animation and staging will change a bit to take better
advantage of efficient, powerful lighting.

Asyou’ll learn in Chapter 10, “Maya Lighting,” virtual lights in Maya are similar
to lights used in the real world, from a single point of light, such as a bulb, to directed
beams, such as spotlights.

11
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Rendering

At this stage, your computer takes your scene and makes all the computations it needs to
create raster (bitmapped) images for your movie. Rendering time depends on how much
geometry is used in the scene as well as on the number of lights, the size of your textures,
and the quality and size of your output: the more efficient your scene, the shorter the ren-
dering times.

A lot of people ask how long they should expect their renders to take or how long is
too long for a frame to render. It’s a subjective question with no real answer. Your frames
will take as long as they have to for them to look the way you want. Of course, if you have
tight time or budgetary constraints, you need simple scenes to keep the render resources
and times to a minimum. In production, you’re always short on time, so having the most
efficient pipeline possible will be your savior. If you don’t work efficiently, your producer
or supervisor eventually will tire of hearing, “But I'm still rendering.”

That being said, it’s important to understand how a scene is put together before you
learn to put a scene together efficiently. While you're learning, use as many lights and as
much geometry as you think you need for your scenes. The more experience you gain, the
more efficient your eye will become.

Core Concepts

CG animation draws from many disciplines. While learning Maya, you’ll work with con-
cepts derived not only from computer graphics, but also from design, film and cinema-
tography, and traditional animation. Here’s a summary of the most important of those
concepts as they apply to Maya.

Computer Graphics Concepts

Knowing a bit about the general terminology and methodology of computer graphics will
help you understand how Maya works. Let’s begin with the crucial distinction between ras-
ter (bitmapped) and vector graphics and how this distinction affects you as a Maya user.

Raster Images

Raster images (synonymous with bitmapped images) make up the world of computer
images today. These images are displayed through the arrangements of colored pixels
onscreen or dots on a print to display an image. Everything you create in Maya will
eventually be seen as a raster image, even though you first create it using vectors.

Raster image programs, such as Photoshop, let you adjust existing settings such as
color, size, and position for all or part of an image. They let you paint onto a scanned
picture or a virtual canvas to adjust or create the pixels yourself. These programs affect
pixels directly, giving you the tools to change pixels to form images. For instance, you can
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use a scanned photo of your house in Photoshop to paint the side of the house red to see
what it might look like before you run down to the local paint store.

A raster or bitmap image is a mosaic of pixels, so the resolution of an image is defined
by the number of pixels in the horizontal and vertical directions. Because they’re based on
a grid of a fixed size, raster images don’t scale up well. The closer you get to a raster image,
the bigger the pixels become, making the image look blocky, or pixelated. To make large
raster images, you need to begin with a higher resolution. The higher the resolution, the
larger the file size will be. Figure 1.1 shows what happens when you blow up a raster image.

Figure 1.1

Most common raster displays are television or computer screens. In fact, the term ras- Arasterimage at its
original size (left)
and blown up sev-
image, the electronics in these devices essentially paint it as a grid of red, green, and blue eral times (right)

ter originally referred to the display area of a television or computer monitor. To form an

pixels on a glowing screen. Every image generated by a computer, therefore, must either
begin as a raster image or be rasterized as part of rendering for display.

Vector Images

Vector images are created in a completely different way. They’re formed using mathemat-
ical algorithms and geometric functions. Instead of defining the color of each and every
pixel in a grid of a raster image, a vector image uses coordinates and geometric formulas
to plot points that define areas, volumes, and shapes.

Popular vector-based image applications include Adobe Illustrator and Flash, as
well as practically all computer-aided design (CAD) programs, such as AutoCAD and
SolidWorks. These programs let you define shapes and volumes and add color and tex-
ture to them through their toolsets. They store the results in scene files containing coor-
dinates and equations of points in space and the color values that have been assigned to
them. This vector information is then converted into raster images (called rasterization)
through rendering so you can view the final image or animation.

When scaled, vector graphics don’t suffer from the same limitations as raster images.
As you can see in Figure 1.2, vectors can be scaled with no loss of quality; they will never
pixelate.
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Figure 1.2

A vector image at
its original size (left)
and blown up quite
a bit (right)

Motion in vector programs is stored not by a long sequence of image files, but through
changes in positions of the geometry and in the math that defines the shapes and volumes.
When a Flash cartoon is played on a website, for example, the information downloaded
and fed to your computer is in vector form. Your computer then renders this information
on the fly in real time into a raster display of the content that you can (you hope) enjoy on
your screen.

When you work in Maya, vectors are displayed as wireframes. When you finish your
scene, Maya renders the image, converting the vector information into a sequence of
raster images you can play back.

Image Output

When you’re done with your animation, you’ll probably want as many people as possible
to see it (and like it!). To make that happen, you have to render it into a file sequence or a
movie file. The file can be saved in any number of ways, depending on how you intend it
to be viewed.

COLOR DEPTH
An image file stores the color of each pixel as three values representing red, green, and

blue. Image type depends on how much storage is allotted to each pixel (the color depth).
These are the color depths common to image files in CG production:

Grayscale The image is black and white with varying degrees of gray in between, typically
256 shades of gray. Grayscale images are good for rendering out black-and-white subjects
as well as being used for some types of texture maps like displacement maps.
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8-Bit Image File (a.k.a. 24-Bit Color Display) Referred to as 24-bit color display or True
Color in desktop settings for Windows, each color channel is given 8 bits for a range

of 256 shades of each red, green, and blue channel, for a total of 16 million colors in the
image. This color depth gives good color quality for an image and is widely used in most
animation applications. Most of your renders from Maya will probably be as 8-bit image
files, because most monitors are only capable of 8-bit color reproduction in playback.

16-Bit Image File Used in television and film work using such file types as TIFF16, a 16-bit
image file holds 16 bits of information for each color channel, resulting in an impressive
number of color levels and ranges. Each file can exceed several megabytes even at low
resolutions. These files are primarily used in professional productions, although they’re
being supplanted by the use of 32-bit images.

32-Bit Image File This is where the big kids play. Used primarily for film work but increas-
ingly in general use, 32-bit image files, such as the OpenEXR format, give you an incred-
ible amount of range in each color channel. This lets you adjust a wide range of tones and
hues in your rendered output for the fullest detail. They’re pretty much standard for film
work because outputting CG to film can require high levels of color and brightness range

in the image.

High Dynamic Range Imagery (HDRI) HDRI images are 32-bit float images that are created
by combining several digital photos into one image file. For example, photos are taken of
a subject with different levels of light using various exposures during photography. With a
“32 bit float” file format, a lot of information can be stored about the colors in the image;
i.e. a very high bit depth is achieved. This way, you have a series of images that range from
dark (with very fast exposure) to normal (with proper exposure time) to blown out bright-
ness (with overexposure). These different exposures are then compiled into a single
HDR file format (.hdr) that represents a wider range of light and dark than a typical photo.
These files are traditionally used as lighting setups, especially for scenes in which CG is
integrated with a live-action background using image-based lighting (IBL), a concept
we’ll touch on in Chapter 11.

COLOR CHANNELS

As mentioned, each image file holds the color information in channels. All color images
have red, green, and blue color channels that, when viewed together, give a color image.
Each channel is a measurement of how much red, green, or blue is in areas of the image.
A fourth channel, called the alpha channel, is used as a transparency channel. This chan-
nel, also known as the matte channel, defines which portions of the image are transparent
or opaque. Not all image files have alpha channels. You can read more about alpha chan-
nels in Chapter 7.

15



16

CHAPTER 1: INTRODUCTION TO COMPUTER GRAPHICS AND 3D

FILE FORMATS

In addition to image types, several image file formats are available today. The most com-
mon is probably JPEG (Joint Photographic Experts Group), which is widely used on the
Internet.

The main difference between file formats is how the image is stored. Some formats
compress the file to reduce its size. However, as the degree of compression increases, the
color quality of the image decreases.

The popular formats to render into from Maya are TIFF (Tagged Image File Format),
Maya IFF (Maya Image File Format), and Targa. These file formats maintain a good 8-bit
image file, are either uncompressed or barely compressed (lossless compression), and are
frequently used for broadcast or film work. These formats also have an alpha channel,
giving you better control when you later composite images together. To see an animation
rendered in a file sequence of TIFFs, for example, you must play them back using a frame
player such as FCheck (which is included with Maya) or IRIDAS FrameCycler, or compile
them into a movie file using a program such as Adobe After Effects.

Ultimately, your final image format depends on the next step in your project. For
example, if you plan to composite your CG, you’ll need to output a format that can be
imported by your compositing or editing program. TIFF files are perhaps the best format
to use, because they’re widely compatible, store uncompressed color, and have an alpha
channel. You might also consider outputting to 16-bit or even 32-bit float images to give
you the greatest range of color when you fine tune the image sequences. For the vast
majority of your work as a beginner, you’ll be working in 8 bit.

MOVIE FILES

Animations can also be output to movie files such as AVI or QuickTime. These usually
large files are self-contained and hold all the images necessary for the animation that they
play back as frames. Movie files can also be compressed, but they suffer from quality loss
the more they’re compressed.

Maya can render directly to an uncompressed AVI movie format, saving you the seem-
ing hassle of having to render out a large sequence of files. Although rendering directly
to an AVI movie may seem like a good idea, it usually isn’t. It’s best to render a sequence
of files that can easily be compiled into a movie file later using a program such as Adobe
After Effects, Premiere, or QuickTime Pro. The primary reason is simple: your render
may crash, or your machine may freeze. In such an event, you need to start your AVI ren-
der from the beginning, whereas with images (like TIFFs) you can pick up right after the
last rendered frame. Rendering frames is just the better way to go.

Color

Color is how we perceive the differences in the wavelengths of light. The wide range
of colors that we see (the visible spectrum) results when any of three primary colors of
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light—red, green, and blue—are “mixed” together. You can mix color in two ways: sub-
tractive and additive. These color definitions are most often displayed in color wheels,
which equally space the primary colors around a ring and place the resultant colors when
primaries are mixed in between the appropriate primaries.

Knowing more about color will help you understand how your CG’s color scheme will
work and help you design your shots with greater authority. (See the reading list at the
end of this chapter for some books that expound on color theory and composition.)

SUBTRACTIVE AND ADDITIVE COLOR

Subtractive color mixing is used when the image will be seen with an external light
source. It’s based on the way reflected light creates color. Light rays bounce off colored
surfaces and are tinted by the different pigments on the surface. These pigments absorb
and reflect only certain frequencies of the light hitting them, in essence subtracting cer-
tain colors from the light before it gets to your eyes. Pile up enough different colors of
paint, and you get black; all the colors are absorbed by the pigment, and only black is
reflected.

When subtractive color mixing is used in painting, the traditional color wheel’s pri-
mary colors are red, yellow, and blue. These three pigments can be mixed together to
form any other color pigment, and they form the basis for the color wheel most people
are exposed to in art education in primary school. In the world of print production,
however, a CMYK (Cyan, Magenta, Yellow, and blacK) color wheel is used. Cyan, yellow,
and magenta ink colors are the primary colors used to mix all the other ink colors for
print work.

Projected light is mixed as additive color. Each light’s frequency adds on to another’s
to form color. The additive primary colors are red, green, and blue. These three colors,
when mixed in certain ratios, form the entire range of color. When all are equally mixed
together, they form a white light.

A computer monitor uses only additive color, mixing each color with amounts of red,
green, and blue (RGB).

Warm colors are those in the magenta to red to yellow range, and cool colors are those
in the green to cyan to blue range of the additive color wheel. Warm colors seem to
advance from the frame, and cool colors seem to recede into the frame.

HOW A COMPUTER DEFINES COLOR

Computers represent all information, including color, as sets of numeric values made up
of binary numbers—O0s and 1s (bits). In an 8-bit color file, each pixel is represented by
three 8-bit values corresponding to the red, green, and blue channels of the image. An
8-bit binary number ranges from 0 to 255, so for each primary color you have 256 pos-
sible levels. With three channels, you have 256 x 256 x 256 (16.7 million) possible combi-
nations of each primary color mixed to form the final color.

17



18

CHAPTER 1: INTRODUCTION TO COMPUTER GRAPHICS AND 3D

Color value can also be set on the hue, saturation, and value (HSV) channels. Again,
each channel holds a value from 0 to 255 (in an 8-bit image file); these values combine to
define the final color. The hue value defines the actual tint (from red to green to violet) of
the color. The saturation defines how much of that tint is present in the color. The higher the
saturation value, the deeper the color will be. Finally, value defines the brightness of the
color, from black to white. The higher the value, the brighter the color will be.

HSV and RGB give you different methods to control color, allowing you to use the
method you prefer. All the colors available in Maya, from textures to lights, are defined
as either RGB or HSV values for the best flexibility. You can switch from HSV to RGB
definition in Maya at any time.

CMYK COLOR

A CMYK color wheel is used for print work, and this is referred to as the four-color pro-
cess. Color inkjet printers produce color printouts by mixing the appropriate levels of
these inks onto the paper.

All output from a computer, which is RGB based, to a printer goes through a CMYK
conversion as it’s printed. For professional print work, specially calibrated monitors
are used to enhance previewing the CMYK color of an RGB image before it’s printed.
Fortunately, only print professionals need to worry about this conversion process,
because most of it is handled by graphics software to a fairly accurate degree.

VIEWING COLOR

The broadcast standard for North America is NTSC (National Television System
Committee). One joke in the industry is that the acronym means Never The Same Color,
referring to the fact that the color you see on one TV screen will be different from what
you see on another screen. The same holds true for computer monitors, especially flat-
panel displays. All displays are calibrated differently, and what you see on one screen
may not be exactly what you see on another screen.

If it’s important to have consistent color on different screens, say on your home and
school computers, you can use traditional color bars downloaded from the Internet or
your own custom-made color chart to adjust the settings of the monitors you work with
so they match more closely. If color is absolutely critical when you’re working in a group,
it’s important for everyone to view color output on a single screen.

Resolution, Aspect Ratio, and Frame Rate

Resolution denotes the size of an image by the number of horizontal and vertical pixels,
usually expressed as # x # (for example, 640 x 480). The higher the resolution, the finer
the image detail will be.



You’ll adjust your final render size to suit the final medium for which you're creating

the animation. Table 1.1 lists some standard resolutions.

NAME SIZE NOTES

VGA (Video Graphics Array) 640 X 480 Formerly the standard computing resolution and still a
popular television resolution for tape output.

NTSC D1 (National Television 720 X 486 The standard resolution for broadcast television in

System Committee) North America.

NTSC DV 720 X 480 Close to the NTSC D1 resolution, this is the typical reso-
lution of digital video cameras.

PAL (Phase Alternation Line) 720 X 586 The standard broadcast resolution for most European
countries.

HDTYV (High Definition TV) 1920 X 1080 The emerging television standard, sometimes also
referred to as 1080i (interlaced frames) or 1080p (pro-
gressive frames).

1K Academy (1K refers to 1024 X 768 Typically the lowest allowable resolution for film pro-

1000 pixels across the frame) duction at Academy ratio (see Table 1.2). Because film is
an optical format (whereas TV is a raster format), there
is no set defined resolution for film. Suffice it to say, the
higher the better.

2K Academy (2K refers to 2048 X 1556  Most studios output CG for film at this resolution, which

2000 pixels across) gives the best size-to-performance ratio.

4K Academy (4K is 4000 pixels 4094 x 3072 A high resolution for film, used for highly detailed shots.

across)

Any discussion of resolution must include the matter of aspect ratio. Aspect ratio is the

ratio of the screen’s width to its height. Aspect ratio standards are shown in Table 1.2.

NAME

SIZE

NOTES

Academy Standard

Widescreen TV

Widescreen Film (a.k.a.
Academy Flat)

Anamorphic Ratio

1.33:1 or4:3

1.78:1 or 16:9

1.85:1

2.351

The most common aspect ratio. The width is 1.33 times
the length of the height. This is the NTSC television
aspect ratio as well as the aspect ratio of 16mm films
and some 35mm films, including classics such as Gone
with the Wind.

With HD and widescreen TVs gaining popularity, the
16:9 standard is commonplace now. This aspect is used
in HD programming and is also the aspect ratio of
many widescreen computer monitors and laptops. This
aspect is very close to the way most films are displayed
(1.85:1, as shown next).

The most-often-used 35mm film aspect today. When
it's displayed on a television, horizontal black bars
appear above and below the picture so the edges
aren’t cropped off (an effect called letterboxing).

Using an anamorphic lens, the image captured to 35mm
film is squeezed. When played back with a projector
with an anamorphic lens, the image is projected with a
width at 2.35 times its height. On a standard TV, the let-
terboxing is more severe to avoid cropping the sides.
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The number of frames played back per second determines the frame rate of the anima-
tion. This is denoted as fps, or frames per second. The following are the three standard
frame rates for media:

+ NTSC: 30fps
« PAL: 25fps
+  Film: 24fps

Knowing your output medium is important when beginning an animation project.
Although it isn’t crucial, it can affect how you design your framing, create your move-
ments, render your project, and so on. You can change the frame rate and render resolu-
tion at any time in Maya, but it’s always better to know as best you can what the final
resolution and fps will be before you begin.

Playing back a 24fps animation at 30fps will yield a slower-moving animation and will
necessitate either repeating some frames to fill in the gaps or ending the animation early.
Conversely, playing a 30fps animation at 24fps will create a faster-moving animation that
will either skip some frames or end later than it should.

3D Coordinate Space and Axes

Three-dimensional space is the virtual area in which you create your models and execute
your animation. It’s based on the Cartesian coordinate system, a geometric map of sorts
developed by the brainy René Descartes. Knowing where you are at all times is essential
with a 3D program. You can do so if you understand the toolset you're working with and
the 3D space in which you’re working.

Space is defined in three axes—X, Y, and Z—representing width, height, and depth.
The three axes form a numeric grid in which a particular point is defined by coordinates
set forth as (#,#,#), corresponding to (X,Y,Z), respectively.

At the zero point of these axes is the origin. This is at (0,0,0) and is the intersection of
all three axes. The 3D space defined by these three axes is called the World axis, in which
the XYZ axes are fixed references. The axis in World Space is always fixed and is represented
in Maya by the XYZ Axis icon in the lower-left corner of the Perspective windows.

Because objects can be oriented in all sorts of directions within the World axis, it’s
necessary for each object to have its own width, height, and depth axis independent of
the World axis. This is called the Local axis. The Local axis is the XYZ-coordinate space
that is attached to every object in Maya. When that object rotates or moves, its Local
axis rotates and moves with it. This is necessary to make animating an object easier as it
moves and orients about in the World axis.

You’ll get a hands-on introduction to Maya’s Cartesian coordinate space in the tutorial
in Chapter 2, “Jumping in Headfirst, with Both Feet,” where you’ll re-create the solar sys-
tem with the Sun placed at the origin, the planets orbiting the World axis and rotating on
their own Local axes, and moons orbiting the planets and also rotating (see Figure 1.3).



Basic Design Concepts

Composition is all about how you lay out your scene and design your colors. Creating a
dynamic frame that not only catches the eye but also informs and intrigues is itself an
art form.

Some background in basic design is definitely helpful, and you’ll want to look at design

books as you further your education in 3D. Understanding the fundamentals of layout

and design makes for better-looking scenes and easier setup. The concepts presented here

will get you started. Design theory may not seem specifically pertinent to CG right now,
but recognizing that there is a logical system behind every pretty picture will help you
progress, both as an artist and as an animator.

Form, Space, and Composition

Space is your canvas. Because your canvas ultimately will be a rendered image, your com-
position needs to fit within your rendered image frame. Whether that frame falls into

a tiny web window or a huge IMAX screen, the basics of design always apply: how you
arrange your forms and divide your space says a lot.

In the design lexicon, form means anything you can see; it has some sort of shape,
color, or texture that distinguishes it from its frame. How your scene’s objects lie in the
frame defines your composition. The space behind and between what is rendered out is
the ground, or background plane. Objects become positive space, and the background
becomes negative space.
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Figure 1.3

The Sun at the ori-
gin, Earth and other
planets orbiting the
World axis while
rotating on their
own axes, and the
Moon orbiting Earth
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Figure 1.4

A purely sym-
metrical frame looks
static; the boy seems
still with nowhere to
go. Framing in thirds

helps create or
heighten a sense of
motion, giving space
for the boy to run.

To viewers, positive space tends to proceed forward from the frame, whereas negative
space recedes. Playing with the position of positive and negative space greatly affects the
dynamics of your frame.

Design a static frame in which the objects are all centered and evenly spaced, and your
viewers will wonder why they’re looking at your composition. Arrange the composition
so that your subjects occupy more interesting areas of the frame in which they play with
negative space, and the eye is drawn all over the frame, creating a dynamic composition.
This principle applies to still images as well as to animation.

In the tutorial in Chapter 10, you’ll use light and shadow to turn a still life of fruit into
a dynamic and interestingly composed frame.

Balance and Symmetry

Balance in a frame suggests an even amount of positive space from one side of the frame
to the other. A frame that is heavier on one side can create a more dynamic composition.
Symmetrical objects in a frame are mirrored from one side to another and create a
certain static balance in the frame. An asymmetrical composition, therefore, denotes

movement in the composition.

A popular technique used by painters, photographers, and cinematographers is called
framing in thirds. With this technique, the frame is divided into a grid of thirds verti-
cally and horizontally. Interesting parts of the frame, or focal points of the subjects, are
placed at strategic locations in the grid. Placing your subject in the lower third makes it
seem small or insignificant, static, or even boring. Placing it in the upper third makes
the image more dynamic, magnifying its perceived scale or importance, and even tells a
better story. Figure 1.4 illustrates the difference between a static, symmetric frame and a
frame based on thirds.
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Contrast

Contrast in design describes how much your foreground subject “pops” from the back-
ground. As you can see in Figure 1.5, when you create an area in your frame that contains
little variation in color and light, the image seems flat and uneventful. Using dark shad-

Figure 1.5
ows and light highlights increases the perceived depth in the image and helps pop out the With low contrast,
subject from the background. Animating contrast can help increase or decrease the depth the subject seems to

disappear into the
background. If you
As you’ll see in Chapter 10, light plays an important role in creating dynamic contrasts add shadows and
highlights, the sub-
ject pops out.

of your frame.

within your frame.

Color

Your use of color also plays a big part in creating impact in your frame. As stated earlier,
warm colors tend to advance toward you, and cooler colors seem to recede into the frame.
Placing a warm color on a subject on a cool background creates a nice color contrast to
help the dynamics of your frame.

Colors opposite each other on the color wheel are complementary colors and usually
clash when put together. Using complementary colors can create a wide variation of con-

trast in your scene.

Narrative

A narrative film is a film that tells a story of a hero, called a protagonist, and that hero’s
struggle against an antagonist. Even in the most abstract concept, there can be a perceived
journey: a change that somehow occurs, even if it’s a change in the viewer as they view
the imagery.
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Convincing art creates a sense of change or arc for the audience. This adds an impor-
tant dimension to your work. When the viewer feels you have something to say, your
work becomes that much more touching.

Basic Film Concepts

In addition to the design concepts used in framing a shot, you’ll want to understand
some fundamental filmmaking concepts.

There’s nothing more important than having a solid, manageable, and achievable plan for

your conceptual goal. Almost everybody in production lays out this plan in advance of the
principle photography. You can’t run into the street with someone else’s expensive camera
and not know what you're going to shoot. CG takes time. Put together a good plan, and

you'll be set for a good production.

Planning a Production

Understanding the paradigm that conventional filmmakers use for their productions will
give you a good structure for planning, creating, and managing your own projects. Most
narrative films are broken into acts, which comprise sequences made up of scenes, which
in turn are made up of shots. By using a similar layout in the scripting and storyboarding
of your own short, you’ll find that the entire production process becomes easier and the
effect of your film is stronger.

Narrative films are typically divided into three acts. The first act establishes the main
characters and the conflict or struggle that will define the story. The second act covers
most of the action of the story as the hero attempts to overcome this conflict. The third
act concludes the film by resolving the action in the story and tying up all the loose ends.

Acts can be deconstructed further into sequences, which are groups of sequential
scenes that unite around a particular dramatic or narrative point.

A scene is a part of a film that takes place in a specific place or time with specific char-
acters to present that part of the story. Films are broken into scenes for organizational
purposes by their locations (that is, by where or when they take place).

Don’t confuse the filmmaking concept of a scene with the word scene in CG terminology. The

latter refers to the elements in the 3D file that make up the CG.

Scenes are then broken into shots, which correspond to a particular camera angle or
framing. Shots break up the monotony of a scene by giving different views of the scene
and its characters. Shots are separated by cuts between each shot.

Shots are defined by angle of view, which is the point of view (POV) of the camera.
Shots change as soon as the camera’s view is changed.
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Lighting

Although CG lighting techniques may seem completely different from lighting in real
life, the desired results are quite often the same. The more you understand how real lights
affect your subjects in photography, the better you’ll be at CG lighting.

Without lights, you can’t capture anything on film. How you light your scene affects
the contrast of the frame as well as the color balance and overall design impact. If the
lights in your scene are too flat or too even, they will weaken your composition and abate
your scene’s impact.

As a good way to understand the essentials of lighting, you should take a look at the
three-point system. This method places a key light in front of the scene, which is the pri-
mary illumination and casts shadows into the scene. The key light is typically placed
behind the camera and off to the side to create a highlight on one side of the object for
contrast’s sake. The rest of the scene is given a fill light. The fill acts to illuminate the rest
of the scene but typically isn’t as bright as the key light. The fill also softens harsh shad-
ows from the key light. To pop the subject out from the background, a back light is used
to illuminate the subject’s silhouette. This is also known as a rim light, because it creates
a slight halo or rim around the subject in the scene. It’s much fainter than the key or fill
lights.

You’ll learn more about Maya lighting techniques in Chapter 10.

Basic Animation Concepts

As mentioned at the beginning of this chapter, animation is the representation of change
over time. This concept is the basis for an amazing art form that has been practiced in
one way or another for quite some time. Although this section can’t cover all of them,
here are a few key terms you’ll come across numerous times on your journey into CG

animation.

Frames, Keyframes, and In-Betweens

Each drawing of an animation—or, in the case of CG, a single rendered image—is called
a frame. The term frame also refers to a unit of time in animation whose exact chrono-
logical length depends on how fast the animation will eventually play back (frame rate).
For example, at film rate (24fps), a single frame lasts 1/24 of a second. At NTSC video rate
(30fps), that same frame lasts 1/30 of a second.

Keyframes are frames in which the animator creates a pose for a character (or what-
ever is being animated). In CG terms, a keyframe is a frame in which a pose, a position,
or some other such value has been saved in time. Animation is created when an object
travels or changes from one keyframe to another. You'll see firsthand how creating poses
for animation works in Chapter 9 when you create the poses for a simple walking human
figure.
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Figure 1.6

Keyframing. In

the first frame of
this sequence, a
keyframe is set

on the position,
rotation, and scale
of the cone.On
frame 30, the same
properties are
again keyframed.
Maya calculates all
the movementin
between.

In CG, a keyframe can be set on almost any aspect of an object—its color, position,
size, and so on. Maya then interpolates the in-between frames between the keyframes set
by the animator. In reality, you can set several keyframes on any one frame in CG anima-
tion. Figure 1.6 illustrates a keyframe sequence in Maya.

Keyframe at frame 1

Frame 5 Frame 10
Frame 15 Frame 20

Frame 25 Keyframe at frame 30
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Weight

Weight is an implied, if not critical, concept in design and animation. The weight of your
subject in the frame is a function of the way it’s colored; its contrast, shape, and location
in the frame; and the negative space around it, to name but a few ways of looking at it. In
animation, weight takes on a more important role. How you show an object’s weight in
motion greatly affects its believability. As you’ll see in the axe tutorial in Chapter 8, creat-
ing proper motion to reflect the object’s weight goes a long way toward producing believ-
able animation.

Weight in animation is a perception of mass. An object’s movement, how it reacts
in motion, and how it reacts to other objects together convey the feeling of weight.
Otherwise, the animation will look bogus—or, as they say, “cartoonish.”

Weight can be created with a variety of techniques developed by traditional animators
over the years. Each technique distorts the shape of the object or character in some way to
make it look as if it’s moving. Although it may seem strange to distort an object’s dimen-
sions, doing so makes its motion more realistic. Chapter 8 will touch more on creating
weight in animation. Here’s a quick preview.

SQUASH AND STRETCH

This technique makes a character, for example, respond to gravity, movement, and inertia
by literally squashing it down and stretching it up when it moves. For example, a cartoon
character will squeeze down when it’s about to jump up, stretch out a bit while it’s flying
in the air, and squash back down when it lands to make the character look as if it’s react-
ing to gravity.

EASE-IN AND EASE-OUT

Objects never really stop suddenly. Everything comes to rest in its own time, slowing
before coming to a complete stop in most cases. This is referred to as ease-out.

Just as objects don’t stop suddenly, they don’t immediately start moving. Most things
need to accelerate a bit before reaching full speed. This is referred to as ease-in. The
bouncing-ball tutorial in Chapter 8 illustrates ease-in and ease-out.

FOLLOW-THROUGH AND ANTICIPATION

Sometimes you have to exaggerate the weight of an object in animation, especially in
cartoons. You can exaggerate a character’s weight, for instance, by using well-designed
follow-through and anticipation.

You should create a bit of movement in your character or object before it moves.
Anticipation is a technique in which a character or object winds up before it moves, like
a spring that coils inward before it bounces.

Likewise, objects ending an action typically have a follow-through. Think about the
movement of gymnasts. When they land, they need to bend a bit at the knees and waist
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to stabilize their landing. In the same way, a cape on a jumping character will continue to
move even after the character lands.
The axe tutorial in Chapter 8 will give you a chance to implement these two concepts.

Physics

In Chapter 12, “Maya Dynamics and Effects,” you’ll see that one of Maya’s most powerful
features is its ability to simulate the dynamics of moving objects. To use that capability
effectively, you need a general awareness of the properties of physics—how objects behave
in the physical world.

Newton'’s Laws of Motion

You need to know three basic laws of motion. Sir Isaac Newton set forth these three laws,
summarized here. Everyone in animation needs to understand the first two laws, because
they play a large part in how animations should look. Coming to terms with the third is

an art:

* An object in motion will remain in motion, and an object at rest will remain at rest
unless an external force acts upon the object. This is called inertia, and understand-
ing it is critical to good animation. You’ll find more on this in Chapters 8 and 9.

+ The more massive an object is, the more force is needed to accelerate or decelerate its
motion. This law deals with an object’s momentum.

+ Every action has an equal and opposite reaction. When you press on a brick wall,
for example, the wall exerts an equal amount of force on your hand. That way, your
hand doesn’t smash through the wall.

Momentum

It’s important to understand what momentum is all about. When an object is in motion,
it has momentum. The amount of momentum is calculated by multiplying the mass of
the object by its velocity. The heavier something is, or the faster it’s moving, the more
momentum it has, and the bigger the bruise it will leave if it hits you. Duck!

That’s why a tiny pebble on the highway can cause such a significant impact on your
windshield, for example. Its sheer speed greatly increases its momentum. Likewise, a
slow-moving garbage truck can bash your car, relying on its sheer mass for its tremen-
dous momentum.

When one moving object meets another object—moving or not—momentum is
transferred between them. So, when something hits an object, that object is moved if
sufficient momentum is transferred to it. For more on this notion, see the axe-throwing
exercise in Chapter 8.
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Summary

In this chapter, you learned the basic process of working in CG, called a workflow or
pipeline, and how it relates to the process of working on a typical live film production. In
addition, you were introduced to the core concepts of CG creation and the fundamentals
of digital images. Some important ideas in design as well as traditional animation con-
cepts were also covered.

Now that you have a foundation in CG and 3D terminology and core concepts, you're
ready to tackle the software. Maya is a capable, intricate program. The more you under-
stand how you work artistically, the better use you’ll make of this exceptional tool.

There is a lot to think about before putting objects into a scene and rendering them.
With practice and some design tinkering, though, all this will become intuitive. As you
move forward in your animation education, stay diligent, be patient, and never pass up a
chance to learn something new. Above all else, have fun.



CHAPTER 2

Jumpine 1 Headfirst,
with Both Feet

I n ﬂL@S Ch&pt@?ﬂ, you’re going to start using Maya and get your groove on.

This will be a quick primer on the Maya interface so you experience tasks right away.
The next chapter will show you more details and provide additional explanations and a
reference of how the entire Maya interface works.

This chapter will take you through the creation of a Solar System project and the
mechanics of animating orbits. With this exercise, you’ll dive into creating simple objects,
setting keyframes, and stacking your animation to get planets and moons to orbit each
other and the Sun. This will expose you to object creation, simple modeling, object com-
ponents, pivot-point placement, grouping and hierarchies, basic keyframing, and timing.

Topics in this chapter include:

You put the U in Ul

Project overview: the Solar System

The preproduction process: planning

Creating a project

The production process: creating and animating the objects
Hierarchy and Maya object structure

The Solar System resumed

Using the Outliner

Outputting your work: playblasting
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You Put the U in Ul

Fire up your computer, and let’s get this project going. This section will introduce you to
getting around the Maya user interface (UI). It may seem difficult at first, but it will make
sense as you move along.

You’ll find everything you ever wanted to know about the interface and more in
Chapter 3, “The Maya 2011 Interface.” The overall goal of this chapter is to expose you
to Maya Ul basics as well as important scene creation and editing tools. You can consider
the next chapter a debriefing of sorts, to fill in UT details that aren’t covered in this chap-
ter. If you prefer, you can skip ahead and get a more detailed rundown of the UI first and
then return to this chapter for your first Maya project experience.

KEYBOARD AND SYMBOL CONVENTIONS USED IN THIS BOOK
The following terms are used throughout this book:

Click and LMB+click refer to a mouse click with the primary (left) mouse button.
RMB-+click refers to a mouse click with the right mouse button.
MMB-+click refers to a mouse click with the middle mouse button.

Shift+click indicates that you should hold down the Shift key as you click with the primary
(left) mouse button.

Shift+select indicates that you're holding down the Shift key as you select the next object
for multiple selections.

Right-click refers to clicking with the right mouse button.

The O symbol next to a menu command indicates that you should click the box ((7) next
to the menu command to open the Options for that command.

A Quick Screen Roadmap

Let’s get to the basics of how Maya is laid out (see Figure 2.1). Running across the top of
the screen, right under the application’s title bar, are the Ul elements: the Main Menu
bar, the Status line, and the Shelf. On a Macintosh system running OS X, note that the
Main Menu bar runs at the very top of the screen, above the application’s title bar.

Figure 2.1 shows the major parts of the Ul In the middle of the interface is the work-
space, which is host to your panels (or Scene windows) and their menu options (known as
views or viewports in some other 3D packages). This is where most of your focus will be;
this is where you create and manipulate your 3D objects.

Click inside the large perspective view panel (named persp) with the mouse to activate
the panel, highlighting its border slightly. Press the spacebar to display a four-panel lay-
out, which gives you top, front, and side views as well as the perspective view. Press the
spacebar in any of the panels to display a large view of that panel.
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Main Menu Bar Status Line  Shelf Figure 2.1
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Preset Display
Layouts

Time Slider, Range Slider, Playback Controls

To the right of the panels is the Attribute Editor / Channel Box. This is where most
of the information (attributes) about a selected object is displayed and edited. Pressing
Ctrl-A toggles between the Attribute Editor and the Channel Box. In short, the Attribute
Editor gives you access to all of an object’s attributes, whereas the Channel Box is a quicker
display of the most commonly animated attributes of the selected object. The Attribute
Editor is typically wider than the Channel Box, so you’ll notice a shift in your view pan-
els when you toggle between them. You can set Maya’s preferences to treat the Attribute
Editor as its own window, to prevent it from displaying on the right side of the UL. More
on this in the next chapter.

Keys and Syntax in Maya

Maya is case sensitive in that it distinguishes between lowercase and uppercase letters.
The conventions of this book will be to always print an uppercase letter to denote which
key you must press, but to specify “Shift + the letter” when you must press the uppercase
of that key. In other words, when we ask you to press the E key, for example, you should
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simply press the E key on your keyboard, lowercase. When an uppercase letter is called

for, the book tells you to press Shift+E, requiring you to enter the uppercase letter E into

Maya. Make sure your Caps Lock key is turned off.

Mouse Controls

Maya requires the use of a three-button mouse, even on a Macintosh system. The click-

able scroll wheel found on most mice can be used as the third button by pressing down to

click with the wheel. Scrolling the wheel lets you zoom into or out of a view panel.

In Maya, you press and hold the Alt key on a PC (or the Option key on a Mac) along

with the appropriate mouse button to move in the view panel:

The left mouse button (LMB) acts as the primary selection button and allows you to
orbit around objects when used with the Alt key.

The right mouse button (RMB) activates numerous shortcut menus and lets you
zoom when used with the Alt key.

The middle mouse button (MMB) used with the Alt key lets you move within the
Maya interface panels, and the mouse’s wheel can be used to zoom in and out as well.

SHORTCUTS TO NAVIGATING

Here’s a rundown of how to navigate Maya. Keep in mind that the Option key is used on a

Macintosh in place of the Alt key on a PC:

Alt+MMB-+click Tracks around a window. Tracking moves left, right, up, or down in two

dimensions; hold down the Alt key, press and hold the MMB, and drag the mouse.

Alt+RMB+click Dollies into or out of a view. A dolly moves the scene’s camera in and out of
the view, essentially zooming the view in and out. To dolly, hold down the Alt key, press and

hold the RMB, and drag the mouse.

Scroll Wheel The scroll wheel, in addition to acting as a middle mouse button, can also dolly
into or out of a view just like the Alt+RMB+click combination. Scrolling up dollies in, and

scrolling down dollies out.

Alt+click Rotates or orbits the camera around in a Perspective window. Orbiting lets you get
around your object to observe it from different vantage points. To orbit, hold down the Alt
key and the LMB. This move is called a tumble. You can’t tumble your view in an orthographic

panel.

Alt+Ctrl+click and drag Dollies your view into the screen area specified in your mouse drag.
Hold down the Alt and Ctrl keys while using the LMB to outline a window in the panel to
execute this bounding box dolly. This action is commonly referred to as a window zoom in

other applications.
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SHORTCUTS TO NAVIGATING (continued)

The ViewCube This part of a panel’s interface lets you easily change your current panel view
from, for example, perspective to side, top, and back to perspective with just a click. By click-
ing an area of the ViewCube (shown here), you can switch to other views inside that panel.
Clicking one of the conical axis markers gives you an orthogonal view from
that direction. Clicking the center square gives you the perspective view.

You can toggle the ViewCube in the preferences by choosing Window -

Settings/Preferences - Preferences and clicking the ViewCube category.

Macintosh Keys The major difference in keys between a PC and a Mac, as far as Maya is
concerned, is that the Option key on a Mac serves the same function as the Alt key on a PC.
Although a few Ctrl key combinations in Windows are accessed via the Command key on

a Mac, Mac users can generally use the Mac’s Ctrl key for their key combinations just as PC

users do.
Figure 2.2

The Maya
Manipulators

Making Selections

Selecting objects in a view panel is as easy as clicking them. If the object is displayed
in Wireframe mode, its wireframe turns green while it’s selected. If the object is
displayed in a Shaded mode, the object’s wireframe will appear around the object.
Shaded mode is a way of seeing your objects in the view panel with a basic surface,
as opposed to a wireframe that you can see through. You’ll see this as you do the fol-
lowing exercise.

As you select an object, its attributes appear in the Attribute Editor or Channel
Box on the right.

To select multiple objects, simply hold the Shift key as you click objects to add to
your current selection. The previous selection’s wireframe turns white, and the new
selection is now green. If you press Ctrl+LMB (that is, press the Ctrl key and click)
on an active object, you’ll deselect it. To clear all of your current selections, click
anywhere in the empty areas of the view panel.

Manipulating Objects

When you select an object and enable one of the transformation tools (tools that
allow you to move, rotate, or scale an object), you’ll see a Manipulator appear at
or around the selected object. Figure 2.2 shows the three distinct and most com-
mon Manipulators for all objects in Maya: Move, Rotate, and Scale as well as the
Universal Manipulator. You use these Manipulators to adjust attributes of the
objects visually and in real time.
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Figure 2.3

The Transform tools
in the Tool Box

Transform
Tools

To activate a Transform tool, select an object and then click
one of the Transform tool icons in the Tool Box, shown in
Figure 2.3.

Try This Let’s put some of this into action, shall we?

Choose Create » NURBS Primitives » Sphere. Drag in a view
panel anywhere on its grid to create a wireframe sphere, and then
size it to your liking. In one of the view panels, press the 5 key on
your keyboard, and the display of the sphere will become solid
gray, as opposed to open wireframe. This is called Shaded mode.
Press the 4 key to return to Wireframe mode.

With the sphere selected, select the Move tool (n) from
the Tool Box. The first Manipulator shown in Figure 2.2 should
appear in the middle of the sphere. The three arrows represent
the three axes of possible movement for the object.

Red is for the X-axis, green is for the Y-axis, and blue is for the Z-axis. Cyan is for free
movement in both axes of the active panel view.

Clicking any one of the three arrows lets you move the object only on that particular
axis. The square in the middle of the Manipulator lets you move the object freely about
the plane of the view panel, regardless of the axis. When you select a Manipulator handle
for movement, it turns yellow. The Free Movement box in the center then turns back to
its regular color, cyan.

Next, select the Rotate tool (-) from the Tool Box, and you’ll see the second Manip-
ulator in Figure 2.2. The three colored circles represent the three axes of rotation for the
object—red for X, green for Y, and blue for Z. Select a circle to rotate the object on that
axis. The yellow circle surrounding the three axis circles lets you freely rotate the object
on all three axes. The Free rotation handle also turns cyan when an axis handle is active.

Now, try selecting the Scale tool (n) to see the third Manipulator in Figure 2.2. By
selecting one of the axis handles and dragging the mouse, you can scale the object in a
nonuniform manner in that axis. The middle cyan box scales the object uniformly on
all three axes.

Try selecting the Universal Manipulator (E). This tool acts in place of all three
Manipulators you just tried. Grabbing the familiar arrows translates the sphere. Selecting
any of the curved arrows in the middle of the edges of the Manipulator box lets you rotate
the sphere in that axis. Finally, selecting and dragging the cyan boxes in the corners of the
Manipulator box lets you scale the sphere. If you hold down the Ctrl key as you drag, you
can scale the sphere in just one axis.

Go ahead and click around the interface some more. Create more primitive objects, and
tool around a bit. Move around the view panels, and see how it feels. Give the tires a good kick.

Enough chatting—Ilet’s jump into the Solar System project.



THE PREPRODUCTION PROCESS: PLANNING

Project Overview: The Solar System

This project focuses on familiarizing you with the fundamentals of navigating Maya,
object creation, hierarchy, and pivots, all of which are important concepts for scene
manipulation and animation within Maya. In this exercise, you'll create and animate a
simple simulation of our working Solar System. (You may have done this in school using
coat hanger wire and Styrofoam balls.) This time-tested tutorial is great practice for get-
ting used to object creation, hierarchies, scene manipulation, UI navigation, and working
with objects and selections. It will show you how to set up hierarchies and give you expe-
rience in working with the proper nodes within a group to create hierarchically layered
animation.

The Preproduction Process: Planning

Every smooth operation begins with a good plan. The more research and focused infor-
mation you gather, the better off you’ll be in your work. For this exercise, you need to
find out where each of the planets is in relation to the Sun and to the other planets and
also how many moons it has.

Starting with the Sun in the center, the planets in order are Mercury, Venus, Earth,
Mars, Jupiter, Saturn, Uranus, Neptune, and Pluto. (We’ll label Pluto a planet for old
time’s sake, even though it was reclassified as a “dwarf planet” by the scientific commu-
nity in 2006.) All these planets actually orbit the Sun in ellipses, but we’ll give them cir-
cular orbits for this exercise. Most planets have a number of moons that orbit them, and
one, Saturn, has large rings that circle around it.

Earth 1 moon

Mars 2 small moons

Jupiter 16+ moons

Saturn 3 large rings and 18+ moons
Uranus 18 moons

Neptune 8 moons

Pluto 1 moon

Creating and animating all those objects may seem overwhelming, but it’s a great
way to become comfortable with Maya and animation. Because the goal of the project is
achievable without making every moon, you’ll cut most of them out of your scene and
make a maximum of two moons per planet.

You can redo this exercise in more detail when you feel more comfortable with Maya.
For instance, if, after you've worked through the exercises in this book, you feel like cre-
ating a much more accurate Solar System with beautifully textured planets and a perfect
starry backdrop, go for it! It will still be a good idea to set up and animate the scene care-
fully, just as you did (or should have done) the first time you worked on this exercise.

The more you run this exercise, the clearer Maya’s scene manipulation and hierarchy
structure will become to you. Art is a marriage of inspiration, hard work, and practice.

37
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Creating a Project

Projects are Maya’s way of managing a scene’s assets. A file and folder structure keeps
your files organized according to projects. You’ll have a project for the Solar System

. exercise.
Figure 2.4

The New Project Start by creating a new project for this assignment. Choose File » Project » New to

window open the New Project window. (Figure 2.4 shows the Windows version; the Mac OS X

version has the same fields.) Files are organized in a particular
way in Maya. The top level of this organization is the Project
folder. Within the Project folder are numerous file folders that
hold your files. The two most important types are the Scenes
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and Images folders. The Scenes folder stores your scene files,
which contain all the information for your scene. The Images
folder stores images you’ve rendered out from your scene. As
with clothing and other items around your house, keeping your
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The scene files discussed in this chapter are included on the CD in a project layout explained
in the following text. Copy the scene files on the CD for this project into your own Project

folders after you create the project.



To create a new project, follow these steps:

1. In the Name field in the New Project window, enter Solar_
System as the name for your project. In the Location box,
type the location where you want to store your projects.

The default location for Windows XP, Vista, and Windows 7
is in the current user’s My Documents folder: My Documents\
maya\projects; for Macs, the default location is Home (/Users/
<yourname>) in the Documents/maya/projects/default folder.
If you prefer, you can put projects in a folder on a second-
ary or external hard drive to keep them separate from your
operating system; this allows for easier backup and is gen-
erally a safer environment.

2. Ifyoure using a Windows system, create a folder on your
hard drive called Projects using Windows Explorer. If
you’re using a Mac, select a drive in the Finder and create
a folder on the drive called Projects. In the New Project
window, click the Browse button and select D:\Projects
(Windows) or <Hard Drive Name>/Projects (Mac) for the
location. Maya will fill in all the other fields for you with
defaults; just click the Use Defaults button. Click Accept
to create the necessary folders in your specified location.
Figure 2.5 shows the completed New Project window in
Windows; except for the drive name, the values are the
same on a Macintosh.

After you create projects, you can switch between them by
choosing File » Project » Set and selecting the new project. Maya
will then use that project’s folders until you switch to or create
another project. You may also select a recent project by choos-
ing File » Recent Projects. Maya by default will list four of your
recent projects and scene files on the File menu for easy access.

DON’T FORGET TO SET YOUR PROJECT!

CREATING A ProjeECT
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Figure 2.5

The completed New

Project window

You should make sure to set your project before continuing with your work. The exercises

in this book are based on projects, and you'll need to set your project whenever you start a

new exercise—otherwise, the scene may not load properly or your files may not save to the

proper locations for that project.
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Figure 2.6

Turning off
Interactive Creation

The Production Process: Creating and
Animating the Objects

As discussed in Chapter 1, “Introduction to Computer Graphics and 3D,” production is

typically divided into phases to make workflow easier to manage. In this project, you’ll

first create the Sun, the planets, and their moons; then, you’ll animate their respective

orbits and rotations.

Creating the Sun and the Planets

The first thing you're going to do is create the Sun and the planets. Follow these steps:

L.

Choose File » New Scene (or press Ctrl+N). Maya asks if you want to save your cur-
rent scene. Save the file if you need to, or click Don’t Save to discard the scene.

By default, Maya’s screen should begin in an expanded perspective view. Press the
spacebar to enable the four-panel view. When you’re in the four-panel view, press
the spacebar with the cursor inside the top view panel to select and maximize it.

To create the Sun, you need a primitive sphere. A primitive is a basic 3D shape. First,
let’s turn off a Maya feature called Interactive Creation that is on by default. Turning
off Interactive Creation allows you to create the sphere at the center of the grid (the

origin) without having to click and drag its size

Sphere =] .. .
otygon Primines | e a| and then reposition it manually. Uncheck Cre-
whde Primitives ]

'F Cylnder =] . L. . .
v . Cre o ate- NURBS Primitives » Interactive Creation to
Lamaras » ane . . .

Terus 2| toggle it off, as shown in Figure 2.6. For more on
¥ Curve Tool Circls =]
e e e 2| how to create primitives with interactive feed-
'enicll Curve Tool
et O back, see the section on primitives in Chapter 3.

With Interactive Creation turned off, choose Create » NURBS Primitives » Sphere.
Doing so places a NURBS sphere exactly at the origin—that is, at a position of 0,0,0
for X,Y,Z. This is good, because the origin of the workspace will be the center of the
Solar System, too.

Select the word nurbsSpherel in the Channel Box to the right of the Maya UI (shown
in Figure 2.7), and enter Sun to rename it. If you don’t see the Channel Box in your
Maya window, please refer to the section on the Channel Box in Chapter 3.

NURBS AND POLYGONS

NURBS and polygons are two types of geometry that you can create and edit in Maya. We'll
explore the uses of each modeling type in Chapter 4, “Beginning Polygonal Modeling,”
Chapter 5, “Modeling with NURBS, Subdivisions, and Deformers, and Chapter 6, “Building the
Red Wagon.”



THE PRODUCTION PROCESS: CREATING AND ANIMATING THE OBJECTS

Always keep in mind that Maya is case sensitive. An object named “sun” is different from an

object named “Sun.”

Naming your objects right after creation is a good habit to develop. Doing so makes

for a cleaner scene file and a more organized workspace. This is particularly impor-

tant if anyone needs to alter your scene file; proper naming will keep them from get-
ting frustrated when they work on your scene.

Maya typically uses an object-naming structure called a humpback style, where words are
slung together without spaces. The first letter of a new word in the humpback name is capi-
talized. An example of humpback style is the name indoorPatioScene. Maya uses this struc-

ture when naming nodes, such as the node name nurbsSpherel.

6. Choose the Scale tool in the Tool Box to activate the Scale Manipulator, and uniformly
scale the Sun sphere up to about four times its creation scale of 1. (Make it a scale of
about 4 in all three axes.) For more precision, you can do one of two things: You can
select the sphere and enter a value of 4 in all three entry fields

(the white window next to the attribute) for the Scale X, Scale Y,

Figure 2.7

a1

Renaming the
sphere in the
Channel Box
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and Scale Z channels in the Channel Box shown in Figure 2.8. Alternatively, you can
enter a value of 4 in the Input box on the Status line along the top of the U, as shown
here. Don’t worry; we’ll take an in-depth look at both of these
methods in the next chapter.

7. After you enter the final value through either method, press
Enter, and the sphere will grow to be four times its original
size (at a scale of 1). When you enter the values in either
the Channel Box or the Input box, a scale of 4 appears in all
three fields, as shown in Figure 2.8, and your Sun expands
in size by a factor of 4. Entering exact values in the Channel

Box or Input box is a way to scale the sphere precisely; using

Figure 2.8

the Manipulator isn’t as precise. The Sun’s Scale values
in the Channel Box

Creating the Planets

Next, you’ll create the primitive spheres you’ll be using for the planets. Leave Interactive
Creation off, and follow these steps:

1. Create a NURBS sphere for Mercury just as you did before, by choosing Create »
NURBS Primitives » Sphere. A new sphere appears at the origin. Click its name in
the Channel Box, and change it to Mercury.

2. Choose the Move tool from the Tool Box to activate the Move Manipulator, and
move Mercury a few grid units away from the Sun in the positive X direction. (Click
the red arrow and drag it to the right.) Leave about two grid units between Mercury
and the Sun.

3. Because Mercury is the second smallest planet and is tiny compared to the Sun, scale it
down to 2 the size of the Sun, or type in 0.2 in all three axes of scale if you choose to
enter the values manually in the Channel Box.

4. Repeat steps 1 through 3 to create the rest of the planets and line them up, placing
each one farther out along the X-axis. Be sure to keep about two grid units of space
between them. Scale each one proportionally as follows:

Venus 0.5
Earth 0.5
Mars 0.4
Jupiter 1.0
Saturn 0.9
Uranus 0.7
Neptune 0.7
Pluto 0.15

These proportions aren’t exactly the same as those found in the real Solar System, but
they will do nicely here. Figure 2.9 shows how your Solar System should look now.
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Figure 2.9

All the NURBS
spheres are lined up
in place (top view).

No, Pluto isn’t actually a planet anymore, but for nostalgia’s sake, we'll include it here in our

Solar System. Poor Pluto!

Using Snaps
Now is the perfect time to start using snaps. Some common snap icons are shown in

Table 2.1. Snap icons are explained in greater depth in the next chapter. These icons run
across the top of the UI just below the Main Menu bar, as shown here.

SNAP ICON NAME DESCRIPTION Table 2.1
- Snap lcons
Snap to Grids Snaps objects to intersections of the view’s grid
- Snap to Curves Snaps objects along a curve
- Snap to Points Snaps objects to object points such as CVs or vertices
- Snap to View Planes Snaps objects to view planes

You use snaps to snap objects into place with precision, by placing them by their pivot
points directly onto grid points, onto other object pivots, onto curve points, and so on.
Here you’ll reposition all the planets slightly to center them on the nearest grid line inter-
section. To do so, follow these steps:

1. Select the first planet, Mercury. Choose the Move tool from the Tool Box, and toggle
on grid snaps by clicking the Snap to Grids icon (-).

2. The center of the Move Manipulator turns from a square to a circle, signaling that
some form of snapping is active. Grab the Manipulator in the middle by this circle,
and move it slightly to the left or right to snap it onto the closest grid intersection on
the X-axis.

3. Select the remaining planets, and snap them all to the closest grid intersection on the
X-axis, making sure to keep about two grid spaces between each of them. Because
the Sun was created at the origin and you haven’t moved it, you don’t need to snap it
onto an intersection.
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SAVING MULTIPLE VERSIONS OF YOUR WORK AND INCREMENTAL SAVING

As you're working on a project, you may want to save multiple versions of your files at various
stages of completion. When working in the professional world, you'll find that clients and art
directors often reconsider animations you've created, sometimes, it seems, just to make you
crazy. So, it's always good to keep as many versions of an animation as you can. Scene files are
reasonably small, and hard disk space is inexpensive. Just keep your Scene folder organized
well—for example, by keeping older versions of scenes in separate subfolders—and you
should have no problems.

Maya’s Incremental Save feature makes a backup of your scene file every time you save
your scene. To enable it, choose File » Save Scene (3, and click the Incremental Save box.
After you've done this, Maya will create a new folder within your Scenes folder with the name
of your current scene file. It will then create a backup of your scene in that folder and append
a number to the filename: for example, planets_001.mb. Every time you save your file, Maya
will create a new backup until you disable the feature by choosing File » Save Scene 0.

The scene files for the projects in this book are provided on the accompanying CD to give
you a reference point for the major stages of each project. These files use a slightly different
naming system than the names generated by Incremental Save (for example, the file on the
CDis planets_vl.mb instead of planets_001.mb), so there is no risk of files overwriting each
other.

For important real-world projects, you may decide to supplement the Incremental Save
backups by using Save Scene As to create named files manually, perhaps following a similar
naming system with a version number appended, at the stages where you've made signifi-
cant changes. Whether you do this or use Incremental Save, it's a good idea to keep written
notes about the differences in each version of a scene file so that whenever you make a sig-
nificant change to a file, you have a record of your work.

If you prefer to name files manually, be sure to use an underscore (_) between the filename
and version number instead of a space. Using spaces in your filenames can create problems

with the software and operating system, especially when you're rendering out a scene.

Making Saturn’s Ring

Now, create the ring for Saturn. To do so, follow these steps:

1. Choose Create » NURBS Primitives » Torus to place a donut shape at the origin.
Remember, Interactive Creation is turned off. You can also try creating the torus
with the Interactive Creation option. In that case, click and drag the mouse to create
the donut shape as you prefer. When you have a ring, use the Move tool to snap it to
the same grid intersection as Saturn. This ensures that both the planet and its ring
are on the same pivot point and share the same center.



THE PRODUCTION PROCESS: CREATING AND ANIMATING THE OBJECTS 45

2. Select the torus shape you've created, and name it Ring (if you haven’t already done
s0) in the Channel Box.

3. While the torus shape is still selected in the top view, press the spacebar to display
the four-panel layout. Place the mouse cursor in the persp view, and press the space-

bar to maximize the Perspective window.

4. Press the F key to focus the perspective display on the ring and on Saturn. Pressing F
centers and zooms in the panel on just the selected object(s).

5. Press 5 to get into Shaded mode, and, with the torus selected, press 3 to increase the
resolution display for the ring. Display resolutions are achieved by pressing the 1, 2,
or 3 key and are further explained in the next chap-

ter. Pressing 3 gives you the smoothest view of the
torus in the view panels. That’s a good thing.

6. From the Tool box, select the Scale tool, and scale

ket Torus:  makeflolonus]

the torus down to 0 or close to 0 in the Y-axis (the
torus’s height, in this case) to flatten it.

You’ll notice that the ring is too fat and is cutting
into the planet. You need to edit the attributes of the
ring to increase the inside radius of the donut shape
and create a gap between the planet and the ring.

7. Press Ctrl+A (Ctrl+A will also work on a Mac) to
toggle the Attribute Editor if it’s not on, and then
click the makeNurbTorusl tab to select its creation e
node. (See Figure 2.10.) LS

bghme: mmabebiorhTorusl

8. Increase the Radius attribute to about 1.5, and
decrease the Height Ratio attribute to about 0.25 to
get the desired effect.

Now all your planets are complete, and you can move Seoienionen
on to the moons. Figure 2.10
Changing the creation
Changing the original attributes or parameters of an object, as you've just done with Saturn’s attributes of the NURBS
. . ) torus in the Attribute
ring, is often referred to as parametric modeling. Editor
Saving Your Work

Save your work, unless you like to live on the edge. Saving frequently is a critical habit

to develop. Power failures and other unforeseen circumstances (such as your pet jump-
ing onto your keyboard) may not happen often, but they do happen, and usually at the
wrong time. (As mentioned in the sidebar “Saving Multiple Versions of Your Work and
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Figure 2.11

The planets and
moons in position in
perspective view

Incremental Saving,” Maya’s Incremental Save feature makes it easy to maintain backups
of your work.) Because you created this as a new project, the Save File window will direct
you to the Scenes folder of that project. Save your scene as planets in the .mb (Maya
Binary) format. (If you’re working in Maya PLE, you can only save your files as .mp files,
which may not be compatible with full versions of Maya 2011. Maya PLE saves scenes as
.mp files simply to differentiate them from full Maya-version saved files.)

The file P1anets_v1.mb in the Scenes folder of the Solar_System project on the CD
shows what the scene should look like at this point.

Creating the Moons
For the planets with moons, create a new NURBS sphere for each moon. For simplicity’s
sake, create a maximum of only two moons for any planet. However, feel free to make all
the moons for all the planets after you get a handle on this exercise.

The first moon will be Earth’s. Use the top view to follow these steps:

1. Create a NURBS sphere, and scale it to about half the size of Earth using the Scale
tool. Visually estimate the size of the moon.

2. Move the sphere to within half a unit of Earth, using the Move tool by the X-axis.
There’s no need to snap it to a grid point, so toggle off the Snap to Grids icon (-).

3. Repeat steps 1 and 2 for the remaining moons, placing them each within half a grid
unit from their respective planets. When placing two moons, place them on opposite
sides of the planet.

4. After you're done with all the moons, their placements, and their sizes, select all the
elements in the scene and press 3 to increase the display resolution on all the spheres.
This gives you a smoother view of the NURBS spheres. When you’re finished, you
should have a scene similar to Figure 2.11 in perspective view. If you don’t, it’s clear

Maya doesn’t like you.
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Applying a Simple Shader

To help distinguish one gray planet from another, attach simple shaders to each of the
planets to give them color. You can easily take care of this task using the Hypershade
window. Follow these steps:

1. Choose Window » Rendering Editors » Hypershade to open the Hypershade window.
This window lists and allows you to edit all the shaders and textures in the scene.
With this window, you create the look of your objects by assigning colors, surface
properties, and so on. You'll notice three default (or initial) shader icons already
loaded. (See Figure 2.12.) For more on the Hypershade window, see Chapter 3.

Figure 2.12
Fla Gt View Bookmads Creste Tebs Gaph Window Opbiend Hela Tll.le HyperShade
5 e e g F e IcE - |- window

2. In the Create Maya Nodes panel on the left of the Hypershade window and under
the Surface heading, click the Lambert icon (a gray sphere) to create a new Lambert
shader node. It appears in the top and bottom of the Hypershade window. Click this
icon eight more times to create a total of nine Lambert shading groups in the Hyper-
shade window.

3. Click the first of the new Lambert nodes (lambert2) in the Hypershade window, and
you should notice its attributes display in the Attribute Editor on the right of the UI.
If you have the Channel Box displayed instead, double-click the shader’s icon to open
the Attribute Editor. At the top, replace lambert2 with Mercury_Color to identify
this material as the one you’ll use for Mercury.

4. Name each of the remaining planets in your animation (Venus, Earth, Mars, Jupiter,

Saturn, Uranus, Neptune, and Pluto).

To rename a node in the Hypershade window, you can also right-click the node’s icon and

choose Rename from the shortcut menu that appears.
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Again, keeping a well-named and organized scene is critical to a smooth animation expe-
rience. It’s much more of a chore to root through dozens of unnamed nodes to find the one
you want. When you’ve finished naming all the material nodes, save your work.

After you've created the shaders, you can assign the appropriate colors to each of them

according to the planet they represent:

1. Double-click Mercury to open its Attribute Editor, if it’s not currently open (see
Figure 2.13).

2. To change the color of the shader, click the gray box next to the Color attribute. This
opens the Color Chooser window, where you can choose a new color from the color
wheel or by adjusting values with the HSV sliders. Because Mercury has a brownish red
appearance, go with an orange color, such as in Figure 2.14 (take note of the HSV values).

Figure 2.13
Mercury’s shading
group in the Attri-
bute Editor
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Figure 2.14
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SETTING KEYFRAMES

As with many other functions in Maya, you can set a keyframe in several ways. Switch to the Anima-

tion menu set by pressing F2. When you're first starting to learn Maya, the best way is to choose Ani-
mate ~ Set Key  to display the Set Key Options dialog box. Here, you're selecting the Option box for
that menu item by clicking the little empty box to the right of the menu
item. The Option box for any particular menu item allows you to set the

options for that function. In this case, you're changing the options for

the Set Key function.
If you choose Animate = Set Key without first changing those options, Maya sets a keyframe for all
the keyable attributes for the selected object. Although this
may seem convenient, it makes for a sloppy scene, especially if the scene must be heavily animated.
Having keyframes for attributes that may not actually be animated creates unnecessary clutter.
In the Set Key Options dialog box shown here, set the Set Keys On option to All Keyable Attributes
instead of the default All Manipulator Handles and Keyable Attributes. Set Channels to From Chan-
nel Box instead of the default All Keyable. (These attributes will remain grayed out until you change

to All Keyable Attributes.) Now, when you

choose Animate > Set Key, you'll set a key-
frame only for the channels that you specify
explicitly through the Channel Box, giving
you greater control and efficiency. All you
have to do is highlight the channel you want
to keyframe in the Channel Box and then
choose Animate - Set Key. Save your settings
by choosing Edit » Save Settings, and then

click Close to close the dialog box.

3. Change the remainder of the shaders as follows:

Mercury Orange-brown
Venus Beige-yellow
Earth Blue

Mars Red-orange
Jupiter Yellow-green
Saturn Pale yellow
Uranus Cyan

Neptune Aqua blue
Pluto Bright gray

Figure 2.15 shows the shading groups.
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Figure 2.15

The Hypershade
window with all
the colored planet
shading groups

el e il

4. Next, apply shaders to the planets. Select a planet in the Perspective window, and
right-click its corresponding material in the Hypershade window to open a mark-
ing menu. Drag up to highlight Assign Material to Selection, and release the button
to select it. You can also use the middle mouse button to drag the material from
the Hypershade window to its planet. Leave the moons set to the default gray color.

When you’re finished, you should have a scene similar to Figure 2.16.
Figure 2.16

The shaded planets
in perspective view

Now that you're finished, you’re ready to animate. Save this file; if you enabled
Incremental Save as recommended earlier, your file won’t be replaced with subsequent
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saves. This way, if you get lost in your animation and need to start fresh, you won’t have
to re-create everything from scratch. You can return to a previous version of the file and

start your animation over.

Creating the Animation

To begin this phase of the project, load the file P1anets_v2.mb in the Scenes folder of the
Solar_System project on the CD to your hard drive, or continue with your own scene file. @
The animation you’ll do for the orbits is straightforward. You’ll rotate the planets
around their own axes for their self-rotation, and then you’ll animate the moons around
the planets for their lunar orbits, and finally you’ll make the planets and their moons
orbit the Sun.
The premise of this exercise deals with hierarchy and pivot points. A pivot point is an
object’s center of balance of sorts. Every object or node that is created in Maya has a pivot
point set at the origin. Because most objects, such as the spheres you created for the plan-
ets, appear at the origin upon creation, their pivot points are automatically centered.
When you move an object, as you've done to position the planets and moons, the pivot
point moves with it. Therefore, all your planets’ and moons’ pivot points are already cor-
rectly positioned at the center of each planet and moon.
Now, you need to set up your scene file’s animation settings:

1. Press F2 to open the Animation menu set. Menu sets are groupings of menu headings in
the Main Menu bar. They’re organized according to the type of task at hand. You’ll
see the first several menu headings change when you switch from one menu set to
another.

2. At the bottom of the UI, you’ll notice a slider bar (the Range slider) directly below
the strip of numbers counting off the frames (the Time slider) in the scene. Using the
Range slider, you’ll set the length of your animation to go from 1 to 240. Enter 1 in the
Scene Start Frame and Range Start Frame boxes (Figure 2.17). Enter a value of 240 in Figure 2.17
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the Scene End Frame and Range End Frame boxes, also as called out in Figure 2.17. TheTime and
Range sliders

3. To the right of the Range slider, click the Anima-
tion Preferences icon (E) (shown here in the con-
text of the lower-right corner of the Maya screen),
click Settings, and set Time to NTSC (30fps), which
is 30 frames per second, or NTSC video speed. Also

see Figure 2.18.
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Figure 2.18

Set Time to 30fps
in the Settings tab
of the Preferences

window.
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Also verify that Up Axis is set to Y and not Z, as shown in Figure 2.18. This ensures
that you've designated the Y-axis to be pointing “up” in the perspective window or
pointing out at you from the monitor in the top view. Y up, as it’s called, is Maya’s
default, but it never hurts to make sure, especially if you’re on a shared computer.

Choose Window - Settings/Preferences - Preferences to open the Preferences window.
Under Settings: Undo, make sure Undo is on (if it isn’t already), and set Queue to Infinite.
Setting Queue to Infinite takes a little more system memory, but it's worth it. With this con-
figuration, you can undo (press Ctrl+Z, Command+Z, or just Z if you're using a Mac) as many

times as it takes to undo any blunders. To close the Preferences window, click Save.

Mercury’s Rotation

Now you’re ready to animate Mercury’s rotation. Follow these steps:

1.

Select Mercury, and press E to activate the Rotate tool. The E key is the hotkey to
invoke the Rotate tool in Maya; pressing it is the same as clicking the Rotate Tool
icon in the Tool Box, as you’ve been doing so far. Press F to focus on Mercury in the
perspective view, or zoom in on it manually.

Make sure you're on frame 1 of your animation range by clicking and dragging the
Scrub bar (refer back to Figure 2.17) to place it at the desired frame. You can also
manually type the frame value of 1 in the Current Frame box.

For Mercury, you’ll set your initial keyframe for the Y-axis rotation. Click the Rotate
Y’s attribute name in the Channel Box to select it (it’s then highlighted in gray, as
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shown in Figure 2.19), and, in the Main Menu bar, choose Animate » Set Key. This
places a keyframe for a rotation of 0 in the Y-axis at frame 1 for the Mercury sphere.

If you followed the advice in the sidebar “Setting Keyframes,” earlier in this chapter, B 519
gure 2.

Setting the initial

keyframe for Mercu-

ry’s Y-axis rotation

only the Rotate Y attribute’s Value box turns from white to
orange to indicate that a keyframe exists for that attribute.

If you left the Set Key command at its defaults, choosing
Animate » Set Key sets keys on all the attributes for the sphere,
turning all their values orange in the Channel Box.

4. Using the Scrub bar in the Time slider, go to frame 240. Grab
the Rotation Manipulator handle by the Y-axis (the green circle), and turn it clock-
wise a few times to rotate the sphere clockwise. You’ll notice that you can rotate the
object only so far in one direction before it seems to reset back to its original starting
rotation. Rotate it as far as it will go, and release the mouse button. Then, click the
Manipulator again, and drag to rotate the sphere as many times as necessary until
you're satisfied.

5. Choose Animate » Set Key with the Rotate Y attribute still selected in the Channel
Box. This sets a keyframe for the new Y-axis rotation at frame 240 for the Mercury
sphere.

6. To play back your animation, you can scrub your Time slider. Scrubbing is using
the mouse to move the Scrub bar back and forth so you can watch the animation
play back in a window. Click in the Time slider on the Scrub bar, hold down the left
mouse button, and move your cursor from side to side to scrub in real time. You

see Mercury rotating in your active view panel, if you set your two keyframes as
described.

Clicking so many things just to set two keyframes may seem like a lot of work, but
you're doing this the long way right now; you’re not yet using any shortcuts or hotkeys.
You'll start using those for the next planet.

You have the self-rotation for Mercury worked out. Mercury has no moon, so let’s get
Mercury orbiting the Sun.

Grouping Mercury for a New Pivot Point

You've learned that every object in Maya is created with a pivot point around which it
rotates, from which or to which it scales, and which acts as the placement point for its X-,
Y-, and Z-coordinates. To orbit Mercury around the Sun, the sphere must revolve around
a pivot point that is placed in the middle of the Sun. If the pivot point for Mercury is
already at the center of itself, how can you revolve it around the Sun?

One idea is to move its current pivot point from the center of itself to the center of
the Sun. That would, however, negate Mercury’s own rotation, and it would no longer
spin around its own center, so you can’t do that. You need to create a new pivot point for
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this object. This way, you have the original pivot point at Mercury’s center so it can self-
rotate, and you have a second pivot point at the Sun so that Mercury can revolve around
that point around the Sun. You’ll accomplish this by creating a new parent node above
Mercury in the hierarchy. What does that mean?

In order not to get too confusing, we’ll take time in the following section to introduce
the concept of Maya object structure: nodes and hierarchies. Save your progress so far, and
open a new blank scene. After this explanation, we’ll resume the Solar System exercise.

Hierarchy and Maya Object Structure

Let’s take a timeout from the Solar System exercise and look at how objects and hierar-
chies work in Maya. On top of everything that you see in Maya—its interface—is a layer
you don’t see: the code. The layer of code keeps the objects in Maya organized through

a network of nodes. How you relate these nodes defines how you’ve built your scene. In
short, using Maya is essentially programming your computer directly to create 3D objects
and animation.

So, having a solid understanding of how Maya defines objects and how they interact is
essential to an efficient and successful animation process. This involves getting an intrin-
sic understanding of how nodes relate, whether it’s a straightforward parent-child hierar-
chy in which one affects the other directly or a more complicated script-driven expression
connecting 15 attributes of several objects to simplify a task.

Understanding Nodes

At its core, Maya relies on packets of information called nodes, and each node carries
with it a group of attributes that in combination define an object. These attributes can
be spatial coordinates, geometric descriptors, color values, and so on. Taken together, an
object’s attributes define it and how it animates. You can define, animate, and intercon-
nect any or all of these attributes individually or in concert, which gives you amazing
control over a scene.

When you're beginning to work with a robust program, the learning curve occasion-
ally spikes. With Maya, these spikes typically involve nodes and their interconnections.
Although the interface automates much of the node creation and relationship process, the
sooner you're exposed to the implications of the node level of objects, the easier it will be
for you to overcome the typical learning curve. Even though you may not actively see that
youre making root-level connections between nodes and attributes, that is exactly what
you’re doing every time you click a command.

Nodes that define the shape of a surface or a primitive are called creation nodes or
shape nodes. These nodes carry the information that defines how that object is created.
For example, a sphere’s creation node has an attribute for its radius. Changing that
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attribute changes the radius of the sphere at its base level. Shape nodes are low on the
hierarchy chain and are always child nodes of transform nodes. The sphere listens to its
creation node attributes first and then moves down the chain to its other nodes’ attri-

butes (such as position, rotation, or scale).

Not all primitives are created with shape nodes, so changes at the creation level may not be
possible on certain objects; some objects are created without a creation node. When you
create a new primitive or an object, make sure the History button () is turned on in the
Status line (see Chapter 3 for more about the Status line and its icons). If it displays a small red

Xin the icon, History is off, and the primitive will be created without a shape node.

The most visible and used nodes are the transform nodes, also known as DAG nodes
(Directed Acyclic Graph nodes). These nodes contain all the transformation attributes
for an object or a group of objects below it. Transformations are the values for translation
(position), rotation, and scale. These nodes also hold hierarchy information about any
other children or parent nodes to which they’re attached. When you move or scale an

object, you adjust attributes in this node.

Try This As an example of working with transform nodes, you can create a sphere and
see what happens in the Attribute Editor as you adjust its position and size. Follow these

steps in a new Maya scene:

1. Press Ctrl+A to toggle the Attribute Editor on the right of the UI or to open it as
its own window if you've set it up to do so in Maya’s preferences. (Ctrl functions the
same on a Mac as on a PC, so Mac users can also use their Ctrl key when called for in
the text.)

The tabs along the top of the window let you switch between the nodes that are
attached to this object. The current tab should be on the sphere’s shape node, called
nurbsSphereShapel. This node contains specific information about the object, but it

isn’t typically a node that you edit.

2. Press W to select the Translate tool. With the sphere still selected, click the nurb-
sSpherel tab in the Attribute Editor to access the sphere’s transforms node. Move
the sphere a little in the X direction. Notice in the Attribute Editor that the Translate
attribute for X has changed. You should also see the change in the Channel Box.

3. Press R to select the Scale tool. R is the hotkey by default in Maya for the Scale tool
and is the same as clicking the Scale tool icon in the Tool Box (n). Scale the sphere
uniformly, meaning equally, in all directions by clicking and dragging the Center
Manipulator handle (the cyan box). Notice that the Scale X, Scale Y, and Scale Z

55
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attributes of the sphere change in the Attribute Editor. In the Attribute Editor, enter
1.0 for the X, Y, and Z Scale values to reset the sphere back to its original size.

4. In the creation node of makeNurbsSpherel, change the radius from 1.0 to 2.0. The
sphere doubles in size because its radius is doubled. Switch back to the transform
node (nurbsSpherel), and note that the Scale X, Scale Y, and Scale Z attribute values
are unchanged. This is because you affected the size of the sphere through its Radius
attribute in the creation node at its root level, not through the Scale attributes in a
higher node. Any changes you make to the Scale attributes take effect after changes
in the lower node. This is a perfect example of how one node’s output (here, the
Radius attribute) changes another node.

Parents and Children

A parent node is simply a node that passes its transformations down the hierarchy chain
to its children. A child node inherits the transforms of all the parents above it. So, by
using hierarchies for the Solar System exercise, you’ll create a nested hierarchy of parents
and children to animate the orbital rotation of the nine planets and some of their moons.

By creating parent-child relationships, you can easily animate the orbit of a moon
around a planet while the planet orbits the Sun. With the proper hierarchy, the animation
of the planet orbiting the Sun automatically translates to the moon. In effect, the planet
takes the moon with it as it goes around the Sun.

Child nodes have their own transformations that can be coupled with any inherited
transforms from their parent, and these transformations affect them and any of their
children down the line.

The revolution of one of the planets around the Sun takes into account its moons,
but those moons can have their own animation to spin themselves around their plan-
ets. You're about to experience this firsthand as you continue the Solar System exercise.
The more you hear about these concepts in different contexts, the easier they will be to
master.

Figure 2.20 shows the Outliner and Hypergraph views with a simple hierarchy of
objects for your reference. The Outliner and Hypergraph show you the objects in your
scene in an outline and flowchart format, respectively. Both of these windows allow you
to access the different levels of nodes (the hierarchy) in a scene and are discussed further
in Chapter 3.

A top parent node called groupl holds its children nurbsConel, nurbsSphere3, and
the nested group node group2. The node group?2 is the parent node of nurbsSphere2 and
nurbsSpherel.
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The Solar System Resumed

If you still feel a little unsure about nodes and hierarchies, take the time to reread the
previous section and try the short exercise again. You’ll practice these concepts as you
resume the Solar System exercise. By the time you’ve finished this exercise, you’ll have a
strong sense of how hierarchies work in Maya, although you should feel free to repeat the
entire exercise if you think that will help you master hierarchies. Understanding nodes
and hierarchies is important to animating in Maya.

If youre new to CG animation, take your time with the following section.

Animating Mercury’s Orbit Around the Sun

Load up your scene from where you last saved it. When you left off, you had created the
self-rotation animation for Mercury and were about to create a second pivot point for the
planet to orbit around the Sun by creating a new parent node for the Mercury sphere.

Figure 2.20

A simple hierarchy
in both the Outliner
and Hypergraph
windows
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Figure 2.21

Grouping Mercury
toitself creates a
new pivot point at
the origin.

To create a new pivot point by making a new parent node, follow these steps:

1. With Mercury selected, press E for the Rotate tool, and then choose Edit » Group

from the Main Menu bar. The Channel Box displays attributes for a new node called
groupl. Notice that nothing about the Mercury sphere changed, except that the Rota-
tion Manipulator handle jumped from where it was originally centered on Mercury
all the way back to the origin, where the zero points of the X-, Y-, and Z-axes collide.
Figure 2.21 shows the new Mercury group and its new pivot location.
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You just created a new Maya object by grouping Mercury to itself. In doing so, you
also created a second pivot point for Mercury, in effect, which was placed by Maya

at the origin by default. Because an object’s Manipulator always centers on its pivot
point when it’s selected, Mercury’s Rotate Manipulator jumped to the origin when
the new parent node became selected upon its creation. That is fortunate for you,
because that happens to be the center of the Sun—exactly where you need it to be for
Mercury to orbit the Sun properly.

. Without unselecting Mercury, click groupl in the Channel Box, and change the

name of this new group to Mercury_Orbit. It’s important to make the distinction
between node names so you never get confused. Now you know that the Mercury
node is the planet sphere itself, whereas Mercury_Orbit is the name of the new parent
node, with which you’ll orbit Mercury around the Sun.

Click anywhere in an empty space in your view window to unselect Mercury_Orbit.
Try selecting it again. Notice that when you click Mercury, you select only the planet
and not the new parent node Mercury_Orbit, the group that has its pivot point at
the center of the Sun. This happens because youre in Object Selection mode (a.k.a.
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Object mode). To select the group Mercury_Orbit, you need to switch into Hierarchy
mode by toggling its icon (m) on the Status line at the top of the U, as shown in
Figure 2.22. Make sure you switch back to Object mode by clicking its icon (ﬂ) in
the Status line. For more on selection modes, see Chapter 3.

4. Go back to frame 1 of your animation. Set a keyframe for Mercury_Orbit’s Rotate Y
attribute by selecting its name in the Channel Box and then choosing Animate » Set
Key from the Main Menu bar.

5. Go to frame 240, grab Mercury_Orbit’s Rotate Manipulator handle by the green
Y-axis, and spin it around the Sun twice in either direction. (It doesn’t matter if you
go clockwise or counterclockwise.) You can also enter 720 (or -720 Object Selection
mode to go in the other direction) in the Rotate Y attribute field in the Channel Box.

6. Choose Animate » Set Key to set a keyframe at frame 240 for Mercury_Orbit. Scrub
your animation to play it back.

Does that make good sense? You'll have the chance to do this a few more times as you
animate the other planets and their moons. However, if you still find yourself a little fuzzy
on this concept (which is perfectly normal), repeat the steps to animate Mercury in a new
scene file if need be. One down, eight to go.

Creating Venus

For your next planet, Venus, follow the same procedure as for Mercury’s self-rotation,
and animate it so that it rotates about itself. Then, create a new pivot point (placed by
default at the origin) by grouping Venus to itself to create a new parent node for that sphere,
and call the new parent node Venus_Orbit. Last, animate Venus_Orbit to revolve around
the Sun just as you did with Mercury_Orbit in the previous steps.

Earth and the Moon

Now you need to animate the third planet, the Earth, in much the same way, except that
this time there will be the added complication of a moon. In addition, instead of choosing
Animate » Set Key to set your keyframes, you’ll use the keyboard hotkey S. (The Earth?
Hey, I can see my house from here!)

Whenever you press S when an attribute is highlighted in the Channel Box, you're essentially
choosing Animate - Set Key. In the Set Key Options dialog box, be sure you've changed Set
Keys On to All Keyable Attributes instead of the default All Manipulator Handles and Keyable
Attributes. Also make sure you've set Channels to From Channel Box instead of the default

All Keyable, as mentioned in the earlier sidebar.
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Toggling on the
Hierarchy mode
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Figure 2.23

Moving the Moon'’s
pivot point to the
center of Earth

To animate Earth and the Moon, follow these steps:

1. Select Earth, and give it its self-rotation animation as you did for Mercury. But this

time, select the rotation channel names in the Channel Box and press S, instead

of choosing Animate » Set Key to set rotation keyframes. Again, if you left the
Animate » Set Key (J at its defaults, pressing S sets keys for all attributes; but if you
followed the advice given previously in the sidebar, only the selected channels are
keyframed.

Select the Moon, and give it its self-rotation animation by spinning it around itself
and keyframing it as you've just done with Earth.

. To spin the Moon around Earth, do what you did earlier in this chapter to spin a

planet around the Sun: group the Moon to itself by choosing Edit » Group, and name
the new parent node Moon_Orbit.

This time, however, you need the pivot point to be at the center of Earth and not at the
center of the Sun object, where it is currently. Follow these steps:

1. Turn on the grid snap, and then press the Insert key to activate the pivot point. If

you're using a Macintosh, press the Home key. The Moon’s Manipulator changes
from a rotation handle to the Pivot Point Manipulator. This Manipulator acts just
like the Move Manipulator, but instead of moving the object, it moves the object’s
pivot point.

Grab the yellow circle in the middle of the Manipulator, and move the pivot point to
snap it to the grid point located at the center of Earth (see Figure 2.23).

. Press the Insert key again (or the Home key on a Macintosh) to return to the Rota-

tion Manipulator for Moon_Orbit. At frame 1, set a keyframe for the Moon’s Y-axis
rotation. Then, at frame 240, rotate the Moon about the Y-axis and set a keyframe.

Return to frame 1.
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Grouping the Moon with Earth

To animate Earth’s orbit of the Sun, you need to make sure the Moon will also follow
Earth around the Sun. Instead of just selecting Earth and grouping it to itself as you've
done for the other two planets, you need to include the Moon_Orbit node in that group.
Follow these steps:

1. Select Earth. Shift+click the Moon_Orbit group while in Hierarchy mode () to
make sure you get the topmost node of the Moon, and then choose Edit » Group.
Name this new parent node Earth_Orbit. Remember, when you select just Earth or the
Moon in Object mode (), the Earth_Orbit node isn’t selected. If you select Earth and
then Shift+click the Moon, you select both objects, but you still don’t select the parent
node Earth_Orbit, which is the group that contains both these objects and has its pivot
point at the center of the Sun. Make sure you select the right group. Keep an eye on
where the Manipulator is when you make your selection. If you have the Earth_Orbit
node selected, its Manipulator should be in the middle of the Sun. We’ll deliberately
illustrate this mistake and its consequences when you animate Pluto a little later.

Make sure you use Hierarchy mode (m) when you click the moon object to select Moon_
Orbit and not just the moon sphere. Otherwise, you'll lose the animation of the Moon orbit-

ing Earth.

2. Setakeyframe for Earth_Orbit’s Rotate Y attribute at frame 1 by highlighting Rotate
Y in the Channel Box and pressing S for the Set Key command. This assumes you've
changed the defaults in Animate » Set Key (J as discussed in the earlier sidebar.

3. Go to frame 240, spin Earth and the Moon around the Sun a few times in whichever
direction and for however many revolutions you want, and set a keyframe at frame 240
as well.

Now the first three planets are going around themselves and around the Sun, with a
moon for the Earth. If you haven’t been saving your work, save it now. Just don’t save over

the un-animated version from earlier.

Creating the Other Planets’ Moons

Repeat this animation procedure for the remaining planets and moons, but leave out Pluto
for now. (Poor Pluto: first it loses out on being a planet, and now it has to wait for last.)

If you find that one of your moons is left behind by its planet or that it no longer revolves
around the planet, you most likely made an error when grouping the moon and planet.
Undo until you're at the point right before you grouped them, and try again. If that still
doesn’t work, start over from the earlier version of the file you saved just before you began

animating it. You'll learn how to fix it in the section “Using the Outliner,” later in this chapter.
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Figure 2.24

The Outliner view
of the planet hier-
archies

Auto Keyframe

You can also use the Auto Keyframe feature when animating the planets and moons.
Auto Keyframe automatically sets a keyframe for any attribute that changes from a pre-
viously set keyframe. For example, an initial keyframe for an attribute such as Y-Axis
Rotation needs to be set at some point in the animation. The next time the Y-Axis
Rotation is changed, Maya will set a keyframe at the current frame automatically.

To turn on Auto Keyframe, click the Auto Keyframe icon (&), which is to the right
of the Range slider. When the icon is red, Auto Keyframe is active.

To use Auto Keyframe to animate the moon orbiting Mars, follow these steps:

1. Turn on Auto Keyframe.
2. Start at frame 1. Select Mars’s moon, and set a keyframe for its Y-axis orbit by high-
lighting Rotate Y in the Channel Box and pressing S.

3. Go to frame 240. Revolve the moon around Mars several times in a direction of your
choosing. Maya automatically sets a frame for Y rotation at frame 240. Save your file.

USE CUBES INSTEAD OF SPHERES

Feel free to create the planets and moons as cubes instead of spheres. That way, you can see
each of their individual rotations much more easily, so you can tell whether the animation is

working properly for you.

Using the Outliner

The Outliner is an outline format listing of all the objects and nodes in your scene. For an
in-depth look at the Outliner, see Chapter 3. For now, let’s look at how to use the Outliner
to illustrate the hierarchies for the planets and moons. When all is good and proper, the
Outliner should look like Figure 2.24. Choose Window -» Out-
liner to open the Outliner window and take a peek at what you

TEN Y, Dutliner

have. If you haven’t yet properly named everything, including
the moons, take this opportunity to do so by double-clicking a
name in the Outliner and entering a new name.

Let’s look at the planet Mars and its layout in the Outliner
to better understand the hierarchy for all the planets. All the
other planets should be laid out exactly like Mars (except the

planets that have just one or no moons).
At the bottom of the hierarchy are Mars’s two moons,

ey ey ey iy Ry Ry ey ey by e

mars_moon and mars_moon2. Each of those moons is spin-
ning on its own pivot point. You grouped each moon to itself,
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created the mars_moon_orbit and mars_moon2_orbit nodes, and placed their pivot
points at the center of Mars to animate their orbits around Mars.

Mars is spinning on its own pivot point, but it needed another pivot point to be able
to orbit the Sun. Because you had to make the moons go with it around the Sun, you
selected Mars, mars_moon_orbit, and mars_moon2_orbit (the top nodes of the moons
that circle the planet Mars) and grouped them all together, placing that pivot point at the
center of the Sun. You called this node Mars_Orbit. This is the parent node because it’s
the topmost node for this group. Wherever this parent node goes, the child nodes that are
under it will follow.

Hierarchies such as this are a cornerstone of Maya animation. It’s imperative that
you’re comfortable with how they work and how to work with them. If you find yourself
scratching your head even a little, try the exercise again. A proper foundation is critical.
Remember, this learning 3D thing isn’t easy, but patience and repetition help a lot.

Correcting Hierarchy Problems Using the Outliner
One of the most common problems you’ll run into with this project is a planet revolv-
ing around the Sun without its moon. To illustrate how to fix it using the Outliner, as
opposed to undoing and redoing it as suggested earlier, the following steps will force you
to make this error with Pluto. Usually, people learn more from mistakes than from doing
things correctly.

Go to Pluto, start the same animation procedure as outlined earlier, and then follow
these steps to force an error:

1. Create Pluto’s own self-rotation by spinning it around itself and keyframing as
before.

2. Do the same for Pluto’s moon’s rotation.

3. Group the moon to itself, and grid-snap the pivot point at the center of Pluto to cre-
ate the moon’s orbit of Pluto.

When Pluto’s moon (pluto_moon) is orbiting Pluto, you’re ready to group the moon’s
orbit and Pluto together to create an orbit of the Sun for both.

4. Here is where you make your mistake. In Object mode, select the sphere for Pluto’s
moon, and select the sphere for Pluto. Your error is that you're remaining in Object
mode instead of switching to Hierarchy mode.

5. Choose Edit » Group to group them together, and call that new node Pluto_Orbit
(following the naming convention you used for the others).

6. Animate Pluto_Orbit revolving around the Sun.

7. Play back the animation.
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Figure 2.25

Pluto’s incorrect
hierarchy

Figure 2.26

Notice that the moon is no longer orbiting the planet. This is because you didn’t

include pluto_moon_orbit in your group Pluto_Orbit. The animation of the moon going

around Pluto is stored in that node; and because it’s no longer

Regrouping objects
in the Outliner

attached to Pluto_Orbit, there’s no moon orbit of Pluto.

Figure 2.25 shows the hierarchy of Pluto and how it’s differ-
ent from that of the other planets: the moon’s orbit node has
been left out of the group. (Earth has been expanded as a con-
trasting example.)

Using the Outliner, you can easily fix this problem. Place
the pluto_moon_orbit node under the Pluto_Orbit node. Go
to frame 1 of the animation, grab the pluto_moon_orbit node
in the Outliner, and use the middle mouse button to drag it to

S % rnw:‘_:;:;::imn ’ the Pluto_Orbit node so that it has a black horizontal line above and
g below it to show a connection, as in Figure 2.26.
] g o i, ' You’ve just grouped pluto_moon_orbit under Pluto_Orbit, a
& :M:o_' practice known as parenting. Now you need to parent pluto_moon
% d:;;::'ot::t;et under pluto_moon_orbit as well. Use the middle mouse button to
drag pluto_moon onto pluto_moon_orbit. When you play back the
. animation, you'll see that the moon is revolving around the planet,

while at the same time Pluto and the moon are orbiting the Sun.

Now that you've corrected Pluto’s layout in the Outliner, it’s similar to the layouts for the

other properly working planets.
The file P1anets_v3.mb in the Scenes folder of the Solar_System project on the CD will
give you an idea of how this project should look. The first five planet systems are grouped

and animated as a reference, leaving the final four for you to finish.

You can add objects to a group by MMB+dragging their listing onto the desired parent node

in the Outliner. You can also remove objects from a group by MMB+dragging them out of

the parent node to a different place in the Outliner.

GROUPING TERMINOLOGY

Grouping terminology can be confusing. Grouping Node A under Node B makes Node A a

child of Node B. Node B is now the parent of Node A. Furthermore, any transformation or

movement applied to the parent Node B will be inherited by the child Node A.

When you group Node A and Node B, both nodes become siblings under a newly created

parent node, Node C. This new node is created just to be the parent of Nodes A and B and is
otherwise known as a null node. To group objects, select them and choose Edit » Group. Par-

enting nodes together places the first selected node under the second selected node. For
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GROUPING TERMINOLOGY (continued)

example, if you select Node A, Shift+select Node B, and then choose Edit » Parent, Node A
will group under Node B and become its child. This is the same procedure as MMB-+dragging

Node B to Node A in the Outliner, as you did with Pluto’s moon and Pluto itself.

Outputting Your Work: Playblasting

What’s the use of animating all this work and not being able to show it? There are several

ways of outputting your work in Maya, most of which involve rendering to images. One
faster way of outputting your animation in a simple shaded view is called playblasting.
Playblasting creates a sequence of images that play back on your computer at the proper
frame rate. Only if your PC is slow, or if you're playblasting a large sequence of frames,
will your playback degrade. In this case, playblasting 240 frames shouldn’t be a problem.

A playblast, as it’s called in Maya, outputs the view panel’s view into an image
sequence or AVI movie. You can also save the image sequence or AVI to disk if you like.
Playblasting is done mainly to test the look and animation of a scene, especially when its
playback is slow within Maya.

When you have your Solar System animated, output a playblast by following these steps:

1. With your animation completed, click in the Perspective panel to make it active in
the four-panel layout (don’t maximize the Perspective window). Press 5 to enter
Shaded mode.

2. RMB+click in the Time slider, and select Playblast (J from the menu, as shown in

Figure 2.27. The Options dialog box is shown for the Playblast options in Figure 2.28.

3. In the Playblast options, set the Viewer to Movieplayer (displayed as QuickTime
when using a Macintosh) and the Display Size to From Window. Check the Save to
File option, and give your Playblast a name. Set the Scale to 1.0.

Figure 2.27

Select the Option
box for Playblast.

Figure 2.28

Options for creating
a Playblast preview
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Figure 2.29

Creating a playblast
movie file is easy.

4. Because you checked the Movieplayer (or QuickTime on a Mac) option, Maya runs

through the animation and creates an AVI movie file on a PC or a QuickTime movie
file on a Mac that is based on the Shaded-mode appearance of the currently active
view panel (which should be the Perspective panel). Because you also checked the
Save to File option, the movie file is saved to disk. By default, it’s saved to the Images
folder for the Solar_System project you created on your hard drive. You can also click
the Browse button to store the playblast video file anywhere you like. For now, click
Browse, and place the file on your desktop. Click the Playblast button.

. When Maya runs through the animation, Windows Media Player on Windows and

QuickTime on a Mac (or whatever your default movie player is set to in your OS)
automatically opens and plays the move file of the animation at the proper speed of
30fps, as shown in Figure 2.29. Now you can share your animation with others with-
out having to open Maya and play it back in the scene.

When you're creating a playblast, make sure you don’t cover the view panel with any other
windows, such as an Internet browser, as you wait for the animation to complete. Doing so
will create a display error in the playblast output. It's best to allow Maya to complete the

playblast before you use the system again.

B Windows Media Playes




Summary

In this chapter, you learned how to start working in Maya by getting around the inter-
face a bit and learning how to navigate the UL Then, you began working by creating a
new project, creating basic objects such as primitives, and placing objects in the scene.
You learned how to place pivot points for objects and how to use snaps to place points
precisely. You had some experience with the Channel Box and Attribute Editor to set
an object’s attributes. You then went on to create simple shaders for your objects and
set keyframes to animate a Solar System. You went over object hierarchy and grouping
conventions to organize and set up your scene better, and finally you learned how to
output a basic playblast video file of your completed animation.

The planet animation you created is based on a system of layering simple actions on
top of each other to achieve a more elaborate result. If you work slowly and in segments,
animation is more straightforward to produce and generally of higher quality. Much of
your time in actual animation, as opposed to setup or modeling, will be spent adjusting the
small things. These small things give the scene life and character. You'll find that finishing
85 percent of a scene will take about 15 percent of the time. The remaining 85 percent of
the time goes into perfecting the final 15 percent of the scene.

SUMMARY
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